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Executive Summary 

The objectives of this project were to 1) develop a computer software solution to model 
the behavior of wet or dry gas from a single-phase sub-sea pipeline release from sea-bed 
to harmless in-air concentration; 2) to utilize the software system to model the behavior 
of gas released from hypothetical sub-sea pipeline ruptures; and 3) to estimate the 
probability of occurrence of pipeline ruptures in the MMS OCS regions using relevant 
historical pipeline spill statistics. 

Minerals Management personnel in the Pacific Region provided example pipeline rupture 
scenarios for use in the model development, testing and impact assessment phases of the 
project. The pipelines selected were 12, 24 and 36-inch diameter systems with varying 
length, depths, operating pressures, environmental conditions and gas types. Detailed 
descriptions of these scenarios are provided in Table 3.1, Table 3.2 and Table 3.3. 

The MMS Pipeline Gas Release Computer Model (WCDgas.exe) delivered with this 
report provides a methodology to predict the behavior of gas discharges from sub sea 
pipelines. The MMS POSVCM oil pipeline discharge model was modified to 
accommodate gas release, the behavior of the gas bubble plume and generation of output 
suitable for air dispersion modeling. A summary of the WCDgas modeling results for the 
example scenarios developed for this project can be found in Table 7.2. Peak gas 
discharge rates ranging from 10,000 to 1.6 million g/s were predicted depending on the 
release characteristics. Release durations between 5 minutes and 3 hours were identified. 

The OCD/5 atmospheric dispersion model developed for MMS was used to model the 
behavior of the gas after exiting the water surface. Modifications were made to this 
software to improve its ease of use and data output reporting. A summary of the OCD/5 
modeling results for the example scenarios developed for this project can be found in 
Table 7.3. The primary hazard surrounding natural gas dispersions in air is the explosive 
zone downwind of the release. The model predicts that this zone will be less than 1200 m 
in all of the cases studied and typically less than 500 m. 

Software installation instructions and a quick guide to the basic use of the software are 
provided in Appendix E. 

The potential damage to marine biota from a gas pipeline rupture will be negligible due 
to the non-toxic nature of the gas, the small release duration and relatively small volumes 
of water affected. The risk to human health and safety will be limited to the explosive 
zone surrounding the gas discharge location and will only be present for the short 
duration of the release (minutes to a few hours at most). 

Based on historical Gulf of Mexico pipeline infrastructure and spill incident data the 
implied frequency of catastrophic gas pipeline releases is 0.43 incidents per year, or one 
every 2.3 years for the Gulf of Mexico Region and 0.0045 incidents per year, or one 
every 220 years for the Pacific Region. 
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Assessing Risk and Modeling a Sudden Gas Release Due to Gas
 
Pipeline Ruptures
 

1 Introduction 
This report was prepared to meet the requirements of topic #3 of the White Paper Solicitation 
M07RS13346 issued by MMS Operational Safety and Engineering Research (OSER). White 
papers were originally requested to “Assess Risk and Model a Sudden Gas Release Due to a Gas 
Pipeline Rupture on the Pacific OCS”. The scope of the original request subsequently was 
expanded to include additional offshore regions, a larger range of pipeline sizes and the delivery 
of a user-friendly computer model similar to the oil pipeline release model developed for MMS 
TAR (MMS TAR report #390). A study team comprised of individuals from SL Ross 
Environmental Research Ltd, Sintef and Well Flow Dynamics was assembled to meet the 
requirements of the request and were contracted to complete the work. SL Ross was the prime 
contractor and was responsible for the spill risk assessment, air-side gas modeling and sensitivity 
modeling components of the study. Well Flow Dynamics developed the gas discharge model for 
the sub sea pipeline ruptures. Sintef completed the modifications of the POSVCM model 
(previous oil pipeline discharge model developed for MMS) to accommodate gas release, the 
behavior of the gas bubble plume and generation of output suitable for the air dispersion 
modeling. 

2 Project Objectives and Goals 

2.1 Objectives 
The objectives of this project were: 

1.	 to develop a computer software solution to model the behavior of wet or dry gas from a 
single-phase sub-sea pipeline release from sea-bed to harmless in-air concentration; 

2.	 to utilize the software system to model the behavior of gas released from sub-sea 
pipeline ruptures as it travels from the discharge point, through the water column, exits at 
the water surface and then disperses in the atmosphere. The effects of gas source and 
environmental input parameters on the ultimate fate and effects of the gas were 
addressed through a sensitivity analysis of these factors, and; 

3.	 to estimate the probability of occurrence of pipeline ruptures in the Pacific, Alaskan and 
Gulf of Mexico OCS regions using relevant historical pipeline spill statistics. 

2.2 Goals 
More specifically, the goals of the project were to: 

1.	 Work with MMS representatives to identify a number of typical sub-sea gas pipeline 
release scenarios of interest. 

2.	 Estimate the probability of pipeline ruptures in the Pacific, Alaskan and Gulf of Mexico 
OCS regions using relevant historical pipeline spill statistics. 
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3.	 Develop a computer model to predict the release rate versus time of gas from a damaged 
(small hole to guillotine rupture) sub-sea pipeline. This gas pipeline release model was 
built by modifying the Pipeline Oil Spill Volume Computer Model (POSVCM) 
previously developed by SINTEF for MMS. This minimized development time and cost 
and resulted in a software implementation similar to that already in use by MMS. 

4.	 Develop and implement algorithms to predict the 3-dimensional (3D) behavior of the gas 
as it rises from the sea-bed to the surface and to predict the source strength and area of 
the gas at the surface over the life of the release. 

5.	 Integrate the results from the sub-sea gas release models to the Offshore and Coastal 
Dispersion (OCD) model previously developed for MMS to predict the zone of influence 
of the in-air gas cloud generated by the pipeline rupture. 

6.	 Document the methods used in the gas release modeling and the steps necessary to link 
the in-water modeling results to the air-side dispersion model. 

7.	 Apply the integrated models to specific US Outer Continental Shelf (OCS) gas pipeline 
release scenarios to demonstrate the systems capability, to determine the sensitivity of 
gas fate to release conditions and environmental variables, and to identify potential 
environmental and health and safety impact zones. 

8.	 Deliver a computer software package that can be used by MMS and others to model user-
defined sub-sea gas pipeline ruptures. 

9.	 Prepare a final report detailing the work completed. 

3 Example Pipeline Rupture Scenarios 

Minerals Management personnel in the Pacific, Gulf of Mexico and Alaskan Regions were asked 
to provide example pipeline rupture scenarios to be used in the model development, testing and 
impact assessment phases of the project. The Pacific Region provided three pipeline setups each 
with a deep and shallow water spill scenario. The pipelines were 12, 24 and 36-inch diameter 
systems with varying length, depths, operating pressures, environmental conditions and gas 
types. Detailed descriptions of the Pacific Region scenarios are provided in Table 3.1, Table 3.2 
and Table 3.3. A single spill scenario has also been developed for the Gulf of Mexico Region to 
enable the implementation of the software in the Region. The characteristics of this scenario are 
provided in Table 3.4. This scenario is identical to the 36-inch Pacific scenarios with the 
exception that Gulf of Mexico specific over-land and over-water meteorological data have been 
specified. More details concerning the use of the data provided in these tables is provided in the 
modeling sections of the report. 
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Table 3.1 Pacific Region 12-Inch Diameter Pipeline Scenario Description 
Gas Pipeline Release: Scenario Details 

Scenario Description 

MMS Region Pacific 

Pipeline Geometry US Metric 
outer diameter 12 in 0.3048 m 

wall thickness 0.5 in 0.0127 m 

inner diameter 11 in 0.2794 m 

length 6 mi 9.6 km 

Flow Conditions 

max. allowable operating press(MAOP) 1440 psi 9928 kPa 

flow rate 12 MMcfd 3.93 m3/s 

minimum shutdown time (min) 2 min 2 min 

gas type locally produced gas 

Rupture Characteristics US Metric 

guillotine break- pipe id 11 in 0.2794 m 

small hole diameter 1 in 0.0254 m 

Deep Water Location (offshore) longitude latitude 

location (decimal degrees) 120.1205 34.3907 

English Metric 
water depth at rupture 800 ft 243.84 m 

bottom water temperature 44 F 6.7 C 

surface water temperature F C 

distance to shore 6 mi 9.6 km 

Shallow Water Location (near shore) longitude latitude 

location (decimal degrees) 120.0658 34.4375 

US Metric 

water depth at rupture 300 ft 91.44 m 

bottom water temperature 53 F 11.7 C 

surface water temperature F C 

distance to shore 3 mi 4.8 km 

Meteorological Information Sources 

Land Side 

SCRAM Mixing Height Station 23230 Oakland/WSO AP 

SCRAM Surface Data Station 23174 Los Angeles Int'l Arpt 

note:pcrammet.exe used to merge files for use in OCD5 

Water Side 

National Data Buoy # 46023 or 46235 

note:buoymet.exe used to modify file and add over water mixing height for OCD5 

note: surface water temperatures as per buoy data 
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Table 3.2 Pacific Region 24-Inch Diameter Pipeline Scenario Description 
Gas Pipeline Release : Scenario Details 

Scenario Description 

Platform / Pipeline name New Facility 

MMS Region Pacific 

Pipeline Geometry US Metric 
outer diameter 24 in 0.6096 m 

wall thickness 0.875 in 0.022225 m 

inner diameter 22.25 in 0.56515 m 

length 35 mi 56 km 

Flow Conditions 

max. allowable operating press(MAOP) 2000 psi 13789 kPa 

flow rate 1000 MMcfd 327.74 m3/s 

minimum shutdown time (min) 2 min 2 min 

gas type 90% methane from LNG facility 

Rupture Characteristics US Metric 
guillotine break- pipe id 22.25 in 0.56515 m 

small hole diameter na in na m 

Deep Water Location (offshore) longitude latitude 

location (decimal degrees) 119.25 33.8696 

English Metric 

water depth at rupture 3000 ft 914.4 m 

bottom water temperature 42 F 5.6 C 

surface water temperature F C 

distance to shore 35 mi 56 km 

Shallow Water Location (near shore) longitude latitude 

location (decimal degrees) 119.2632 34.163 

US Metric 
water depth at rupture 160 ft 48.768 m 

bottom water temperature 57 F 13.9 C 

surface water temperature F C 

distance to shore 3 mi 4.8 km 

Meteorological Information Sources 

Land Side 

SCRAM Mixing Height Station 23230 Oakland/WSO AP 

SCRAM Surface Data Station 23174 Los Angeles Int'l Arpt 

note:pcrammet.exe used to merge files for use in OCD5 (edit file for year format) 

Water Side 

National Data Buoy # 46023 

note:buoymet.exe used to modify file and add over water mixing height for OCD5 

note: surface water temperatures as per buoy data 
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Table 3.3 Pacific Region 36-Inch Diameter Pipeline Scenario Description 
Gas Pipeline Release : Scenario Details 

Scenario Description 

Platform / Pipeline name New Facility 

MMS Region Pacific 

Pipeline Geometry English Metric 
outer diameter 36 in 0.9144 m 

wall thickness 1 in 0.0254 m 

inner diameter 34 in 0.8636 m 

length 13 mi 20.8 km 

Flow Conditions 

max. allowable operating press(MAOP) 1500 psi 10342 kPa 

flow rate 1400 MMcfd 458.84 m3/s 

min shutdown time (min) 2 min 2 min 

gas type 90% methane from LNG facility 

Rupture Characteristics English Metric 
guillotine break- pipe id 34 in 0.8636 m 

small hole diameter na in na m 

Deep Water Location (offshore) longitude latitude 

location (decimal degrees) 117.4595 32.5227 

English Metric 
water depth at rupture 3000 ft 914.4 m 

bottom water temperature 42 F 5.6 C 

surface water temperature F C 

distance to shore 13 mi 20.8 km 

Shallow Water Location (near shore) longitude latitude 

location (decimal degrees) 117.2973 35.5227 

English Metric 
water depth at rupture 160 ft 48.768 m 

bottom water temperature 57 F 13.9 C 

surface water temperature F C 

distance to shore 3 mi 4.8 km 

Meteorological Information Sources 

Land Side 

SCRAM Mixing Height Station 23230 Oakland/WSO AP 

SCRAM Surface Data Station 23188 San Diego/Lindbergh Fld 

note:pcrammet.exe used to merge files for use in OCD5 (edit file for year format) 

Water Side 

National Data Buoy # 46023 

note:buoymet.exe used to modify file and add over water mixing height for OCD5 

note: surface water temperatures as per buoy data 
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Table 3.4 Gulf of Mexico Region 36-Inch Diameter Pipeline Scenario Description 
Gas Pipeline Release : Scenario Details 

Scenario Description 

Platform / Pipeline name New Facility 

MMS Region Gulf of Mexico 

Pipeline Geometry English Metric 
outer diameter 36 in 0.9144 m 

wall thickness 1 in 0.0254 m 

inner diameter 34 in 0.8636 m 

length 13 mi 20.8 km 

Flow Conditions 

max. allowable operating press(MAOP) 1500 psi 10342 kPa 

flow rate 1400 MMcfd 458.84 m3/s 

min shutdown time (min) 2 min 2 min 

gas type 90% methane from LNG facility 

Rupture Characteristics English Metric 
guillotine break- pipe id 34 in 0.8636 m 

small hole diameter na in na m 

Deep Water Location (offshore) longitude latitude 

location (decimal degrees) 117.4595 32.5227 

English Metric 
water depth at rupture 3000 ft 914.4 m 

bottom water temperature 42 F 5.6 C 

surface water temperature F C 

distance to shore 13 mi 20.8 km 

Shallow Water Location (near shore) longitude latitude 

location (decimal degrees) 117.2973 35.5227 

English Metric 
water depth at rupture 160 ft 48.768 m 

bottom water temperature 57 F 13.9 C 

surface water temperature F C 

distance to shore 3 mi 4.8 km 

Meteorological Information Sources 
(data from Douglas 2008) 

Land Side (OCD Group 4a & 4b) 

Upper Air Station ID 53813 Slidell 

Weather from various sources New Orleans 

note:pcrammet.exe used to merge files for use in OCD5 (edit file for year format) 

Water Side (OCD Group 4a & 4b) 

National Data Buoy # 42007 

note:data pre-formatted to OCD structure by Douglas, 2008 

note: surface water temperatures as per buoy data 
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Region 1996 1997 1998 1999 2000 2001 2002 2003 2004 2005

4 Probability of Gas Pipeline Ruptures 

In this section, the occurrence rate of gas pipeline ruptures is examined. Accident statistics from 
the Gulf of Mexico and Pacific regions are summarized, then compared with the exposure factor 
of “mile-years” of pipeline service to produce an accident rate. 

4.1 Pipeline Incidents 
MMS maintains a record of pipeline incidents, and publishes this information on the web (MMS 
2009). Information is based on that contained in the MMS Technical Information Management 
System, and records are available for the years 1996 to 2006. For that eleven-year period, Table 
4.1 shows the annual breakdown of pipeline incidents for the Gulf of Mexico (GOM) and Pacific 
Regions. 

Table 4.1 All pipeline incidents in GOM and Pacific Regions, 1996 to 2006 
2006 

GOM 7 13 2 7 7 11 8 9 8 6 0 
PAC 0 0 0 1 0 0 1 0 0 0 0 
Total 7 13 2 8 7 11 9 9 8 6 0 

A total of 80 pipeline incidents were reported for the years 1996 to 2006. Of these, only five 
involved a catastrophic rupture of a gas pipeline, summarized below in Table 4.2, with each 
incident described briefly below. 

Table 4.2 Gas pipeline incidents involving a catastrophic rupture 
2006 

GOM 0 0 0 0 0 1 3 2 0 0 0 
PAC 0 0 0 0 0 0 0 0 0 0 0 
Total 0 0 0 0 0 1 3 2 0 0 0 

4.1.1 Incident Summaries 

April 29, 2001 
Texaco Exploration and Production Pipeline segment no. 10393 
South Marsh Island, Block 236 Water Depth: 14 feet 
An incoming 2-inch gas lift line was ruptured. The break caused damage to the upper work deck, 
handrails, flowline, and riser. The line appeared to have been pulled from the structure prior to 
the rupture possibly by a shrimp vessel since the line was buried. Personnel working on an 
adjacent well heard the bleeding gas, reported the incident to Texaco personnel who immediately 
shut-off the supply of gas to the line. No injuries or pollution were reported. 
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January 3, 2002 
Chevron USA Inc. Pipeline segment no. 13154 
West Cameron, Block 48 Water Depth: 22 feet 
During an ESD shut-in, the 10-inch incoming shutdown valve closed, but the safety system on 
the platform failed to operate. Shortly after, the platform operators noticed gas bubbles in the 
water approximately 300 feet from the platform. The pipeline, which was 37 years old, was 
allowed to bleed for 90 minutes, and was later found to have ruptured in three places. It appears 
that the safety system failure was due to freezing problems in the ¼-inch tubing, which runs 
approximately 40 feet to the transmitter. 

January 15, 2002 
Transcontinental Gas Pipeline Company Pipeline segment no. 1526 
Vermillion, Block 67 Water Depth: 40 feet 
The operator at an adjacent platform reported a pipeline rupture with a fire on the water, located 
½ to ¾ miles west of their location. Within 2 hours Transco confirmed it was their pipeline, a 16­
inch gas pipeline. The pipeline was shut it in and the fire ceased. No injuries or pollution were 
reported. 

July 6, 2002 
ChevronTexaco Corporation Pipeline segment no. 3540 
South Marsh Island, Block 217 Water Depth: 15 feet 
The pipeline was reported as having ruptured, with the ensuing fire having flames 100 feet high. 
The location of the rupture was 6000 feet north of SM 217 A. The flames lasted for 2 hours. The 
pipeline PSL shut-in the platform at the time of the rupture. 

January 7, 2003 
Walter Oil & Gas Corporation Pipeline segment no. 11052 
South Timbalier, Block 260 Water Depth: 303 feet 
A vessel moored 2.2 miles from the platform snagged the associated gas pipeline while 
retrieving its anchor. The vessel began pulling up the anchor and halted the operation an hour 
later when the Captain realized he had snagged a heavy object. Ten minutes later, the Captain 
noticed fire and smoke under the platform and notified the USCG. Subsequently, the platform 
operator felt several jolts to the platform that intensified in strength and eventually rocked the 
platform. The operator shut-in the platform’s two producing wells. About 10 minutes later, the 
platform was jolted again: the gas pipeline broke loose and an explosion and fire erupted from 
the severed pipeline beneath the platform. The three individuals on the platform at the time 
evacuated the facility via helicopter. The vessel had been moored outside of the designated 
lightering area per the instructions of the Mooring Master. The Mooring Master and the Captain 
were unaware of any pipelines in the mooring area as apparently neither one had a copy of the 
pipeline overlay to the NOAA nautical chart. 
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Year

December 2, 2003 
South Pipeline Company, LP Pipeline segment no. 5105 
Eugene Island, Block 39 Water Depth: 10 feet 
A dredge barge, dredging the Atchafalaya Channel for the Corp of Engineers, impacted and 
severed the 20-inch gas pipeline. The barge was dredging the channel floor to a depth of 22 feet 
BML in the vicinity of the pipeline; however, the burial depth of the pipeline was not known. A 
representative of the pipeline company was not on board at the time of incident. The project 
engineer did not account for the length of the dredge (420 feet) in determining where to halt 
dredging operations relative to the location of the pipeline. The pipeline caught on fire as a result 
of the impact from the dredge. Approximately 1,500 feet of pipe was pulled apart or ripped. 

4.2 Exposure Factor 
A rational exposure factor must be used in order to express an accident statistic as a rate. For 
pipeline accidents, the most commonly used factor is the length of pipeline, times the years of 
service, resulting in “mile-years” of exposure. 

The “Pipeline Masters” database maintained by MMS for the Gulf of Mexico was used to 
estimate the length of gas pipeline in operation during each year from 1996 to 2006. (MMS 
2009). The focus of this analysis was on gas pipelines, so pipelines with product code 
designations of Gas, G/C, BLKG and BLGH were used in the analysis. Pipelines with Flare, 
Injection and Supply product codes were excluded from the analysis because these smaller 
pipelines are not of primary concern in this study. The length of Lift lines was determined 
separately as there has been one spill incident reported in the GOM for a Lift line. Pipeline 
segments with no reported length, no indication of the date of start of operation (construction 
date, approval date, pressure test date), and those with a status of abandoned but with no date of 
abandonment were excluded from the assessment. The total length of gas pipeline, according to 
the above assumptions, is summarized in Table 4.3. 

Table 4.3 Total length of gas pipeline in the Gulf of Mexico Region, 1996 to 2006 
Pipeline length, 

miles 
1996 12,851 
1997 13,579 
1998 14,156 
1999 14,530 
2000 14,819 
2001 15,491 
2002 16,338 
2003 16,888 
2004 17,404 
2005 17,741 
2006 17,849 
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There is approximately 188 miles of gas pipeline in the Pacific Region, approximately 1% of the 
total in the GOM region. 

4.3 Probability Estimates 

Summing the lengths for each year in Table 4.3, results in a total of 171,645 mile-years of 
pipeline operation. For the 11-year record under consideration, there were five incidents in the 
Gulf of Mexico involving a catastrophic rupture of a gas pipeline. The estimated incident rate is 
therefore (5 / 171,645 mile-years) equal to 2.9 x 10-5 incidents per mile-year. 

As noted above, one of the five incidents involved a gas lift line. These comprise a much smaller 
subset of the above numbers, for a total of 5,407 mile-years. With one incident reported, the rate 
for gas lift lines is 1.8 x 10-4 incidents per mile-year. 

If gas lift lines were excluded from the analysis, the total pipeline length under consideration 
becomes 166,238 mile-years, and with four incidents, the incident rate becomes 2.4 x 10-5 

incidents per mile-year. 

The total length of gas pipeline in the Gulf of Mexico, not including gas lift lines, as of 2008, is 
17,777 miles. Based on a rate of 2.4 x 10-5 incidents per mile-year, the implied frequency of 
catastrophic incidents becomes 0.43 incidents per year, or one every 2.3 years. 

There were no incidents reported for the Pacific Region. The incident rate estimate derived from 
the GOM dataset has been applied to the Pacific Region. The total length of gas pipeline in the 
Pacific Region is 188 miles. Based on the GOM rate of 2.4 x 10-5 incidents per mile-year, the 
implied frequency of catastrophic incidents for the Pacific Region becomes 0.0045 incidents per 
year, or one every 220 years. 
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5 Sub Sea Pipeline Gas Release Model 

5.1 General Model Characteristics 
The MMS Pipeline Gas Release Computer Model (WCDgas.exe) delivered with this report 
provides a methodology to predict the behavior of gas discharges from seafloor pipelines. The 
model can be used for worst-case guillotine break scenarios as well as smaller diameter 
punctures. The primary focus in this study has been on worst-case release scenarios as this was 
the main interest of MMS in this project. Inputs to WCDgas are parameters describing the 
configuration and characteristics of a pipeline system, the fluid it contains, and the leak or break 
from which the discharge occurs. Key outputs are the evolution of the release rate over time, the 
total mass of gas released, and an estimate of its surfacing rate and area of the boiling zone. The 
system is composed of a Release Module (that determines the gas release rate at the seafloor 
from the pipeline rupture) and a Near Field Module (that models the movement of the gas from 
the seafloor to the water surface), linked together with necessary databases through a Graphical 
User Interface (GUI). 

Limitations of application are: 
 Single “tree” pipeline networks with all branches (pipelines) converging toward a 

single outlet point at its root; 
 No closed re-circulating loops; 
 One and only one leakage point; 
 Maximum of 100 pipeline segments per branch (i.e. between junctions) and 5 

junction points; 
 Maximum of 5 pipeline segments attached to a single junction; 
 Only pipeline objects may connect directly to junctions or connectors; 
 Pipeline object connected to non-pipeline objects at both ends; 
 Maximum of 50 branches (series of Pipeline objects between junctions); 
 Connection object connects exactly two pipeline objects; 
 Junction object connects at least 3, and not more than 10 pipeline objects; 
 An Inlet must be at the start of an incoming branch; 
 Outlet object must connect to only one incoming pipeline object; 
 Leakage point must be attached to a Pipeline object 
 Diameter of leak cannot exceed pipe diameter. (This is checked and corrected 

automatically in the Release Module.) 

Necessary inputs for simulation of a given scenario are: 
 Gas composition: 

- Fraction of each component in the gas (mol %) 
- Mol weight for each component (can use defaults provided) 
- Liquid densities (g/cm3) 

 Flow inlet properties: 
- Depth (positive down; negative above mean sea level) 
- Total gas flow rate 
- Fluid temperature 
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- Closing (or shut-in) time 
 Pipeline or riser segment 

- Length 
- Inside diameter 
- Roughness coefficient (can default to 5.0 x 10-5) 
- Heat transfer coefficient (can default to 1 J/s) 
- Ambient temperature 

 Pipe connector or junction 
- Depth 

 Outlet (to remainder of pipeline system or storage 
- Depth 
- Fluid pressure 
- Closing (or shut-in) time 

 Leak properties 
- Distance from upstream endpoint 
- Nominal diameter (not larger than pipeline diameter) 
- Water depth. 

5.2 Model Installation Instructions 
Run the file WCDgas_2-0_Setup.exe to install the program. Follow the instructions provided in 
the installation package. Detailed instructions for installing and running all of the software 
components delivered in this project are provided in Appendix E. 

5.3 Basic Model Use Instructions 
Double-click the WCDgas.exe file or the WCDgas icon on the desktop and the main program 
window appears with an empty work desk, Figure 5.1. The first row of menu items are referred 
to as the “Main Menu” items in the remainder of this report. All functions of the model can be 
accessed from the main menu. The second row of menu items are basic file handling options. 
The third row houses a number of icons that provide quick access to pipeline objects, pipeline 
integrity checking and scenario calculation initiation. 

Click objects on the toolbar (either using the third row icons or the drop-down submenu items in 
the Object menu) and click again on the work-desk to construct a diagram of the pipeline system 
of interest. Alternatively open a pre-defined scenario from the ‘File’ menu option. When the 
diagram is printed or saved, the contents of the work-desk will be saved. All of the pipeline 
network information and leak characteristic for a scenario are saved in a file with an extension 
designation of “wcd”. The saved data is retrieved from this file when the scenario is re-opened 
using WCDgas. 
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Figure 5.1 Main window for WCDgas. 

5.3.1 Create a New Scenario 

A scenario consists of a constellation of connected objects, each assigned a set of parameters. 
Under the Object menu or on the object toolbar there are six options: 

 Pipeline 
 Connection 
 Junction 
 Inlet 
 Outlet 
 Leakage 

The parameters defining each object are given in Table 5.1. 

Choose the component you want to place on your work desk, and click it into the work area. An 
example pipeline network is shown in Figure 5.2. 

When a pipeline segment or leak point is inserted into the work area, it will appear with small 
green boxes defining the connection points. Pipeline segments can be resized by dragging one of 
these green boxes. Objects can be moved on the work-desk by click-and-drag. 
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Object

Table 5.1 Parameters defining objects in a discharge scenario 

Parameters 

Pipeline 
Segment 

Length Diameter Roughness Heat Transfer 
Coefficient 

Ambient 
Temperature 

Connector Depth 
Junction Depth 
Inlet (Flow 
Source) 

Depth Flow Rate Fluid 
Temperature 

Closing (or 
Shut-in) Time 

Outlet (Flow 
Sink) 

Depth Pressure 

Leak Point Distance from 
upstream 
endpoint 

Nominal 
Diameter 

Depth at leak 
location 

Back Pressure 

To delete an object, click on the object and press the Delete key (or use the Delete command 
under the Edit menu). 

All objects must be connected together before a scenario will run. Pipelines and Leak Points can 
connect to Connectors, Junctions, Inlets, and Outlets at any of their blue connection markers. The 
green box in the center of the Leak Point, or at the end of the Pipeline segment, will turn red 
when the connection has been properly made. 

To verify that a connection has been properly made, click and drag the Connector, Junction, 
Inlet, or Outlet (not the Pipeline Segment or Leak Point), and see that the attached object follows 
after. (Clicking on the pipeline element will detach it from its connectors and junctions.) 

Notes: 
1.	 When opening an existing scenario, some pipelines may appear to be disconnected from 

their junctions and connectors. This is a visual effect resulting from the use of long text 
strings in names of elements, and does not affect the integrity of the scenario. These text 
strings mask the placement of objects. Simply click on the junctions and connectors, and 
the pipelines will return to their correct positions. 

2.	 The layout on the desktop is generally not to scale. Only the parameters such as length 
and depth) allocated to each element in the diagram are used in the actual calculations. 
Moving an object manually on the desktop will not alter the basis for the computations in 
the WCDgas. 
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Figure5.2 Example Pipeline Network 

5.3.2 Object Properties 

After placing a selected object one has to supply required parameters. Right-click the object and 
choose Properties, or double-click and the Properties box appears. Fill in specifications for each 
object. Figure 5.3 shows the Object Properties dialog boxes. The following sections provide 
additional details regarding the data entered in these dialogs. 

5.3.2.1 Flow Inlet Specifications 

For every flow inlet in the network the depth, total gas flow rate, fluid temperature and the 
closing time have to be specified. The specified flow rate is fixed until the inlet choke closes. 
The closing time is the duration from the time the leak occurred to the time production is shut 
down. 

5.3.2.2 Flow Outlet Specification 

In contrast to the inlet specifications where several inlets are possible, only one pipeline outlet 
can be specified. At the pipeline (or network) outlet, the receiving pressure is required. The 
outlet pressure is the fixed pressure at the outlet of the pipeline, typically upstream of a choke at 
the receiving facility. This receiving pressure is usually known. 
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Figure 5.3 Object properties input dialogs. Labeling objects is not required, but is 
recommended as an aid in locating problems with the scenario setup. 
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Note: The outlet pressure can be the same as operating pressure, but that depends on the 
definition of "operating pressure". Usually, the "operating pressure" is used in connection with 
the "maximum operating pressure" and is the design limit of the pipeline or equipment, i.e. the 
pressure should not exceed the maximum anywhere in the system. Operating pressure can be this 
pressure, it can be the pipeline input pressure, or it can be an average pressure in the pipeline. 
Based on the user specified flow rate and the outlet pressure, the model calculates the pressure 
drop and hence, the pipeline inlet pressure as well as the entire pressure profile in the pipeline 
network. 

The software handles networks with several inlets, but only one outlet and one leak or rupture as 
seen example in Figure 5.4. 

Figure 5.4 Example of a network with two inlets and one outlet 

5.3.2.3 Pipeline Properties 

Pipelines should be modeled with several pipe segments to account for the seabed topography 
and variation in inclination. Every pipeline segment is labelled with a description, given a length 
and an internal diameter. A pipeline has to be connected to an inlet, connection, junction or 
outlet. 

The pipe roughness is used when calculating the frictional pressure drop in the pipeline. The 
internal pipe roughness for the gas pipelines will usually be low, typically 10E-5 ft, and smaller 
changes are not believed to have a significant effect on the pressure drop. 

The overall heat transfer coefficient “U” is used to calculate the heat transfer from the fluid and 
radially through the pipe wall layers to the surroundings at ambient temperature. 

A typical U value for an unburied, un-insulated pipeline can be 10 btu/(hr ft2 degF). A typical U 
value for an insulated (and buried) pipeline can be 0.5 - 2 btu/(hr ft2 degF). 
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5.3.2.4 Pipeline Connection 

A pipeline is usually modeled with several pipeline segments with different angles. Between two 
segments, a connection is included with a depth specification. 

5.3.2.5 Pipeline Junction 

A pipeline junction defines a point with three or more pipelines are connected and is used when 
modeling networks. The required input data is depth. 

5.3.2.6 Leakage Properties 

The leak is modeled by a critical choke with a diameter equal to the leak size. The leak is 
snapped to a pipeline and the distance from the upstream end of the pipe is specified. The water 
depth is used to calculate the ambient back-pressure at the leakage. 

For large ruptures, the simulations can become unstable because of rapid pressure transients. A 
workaround is to run the simulation with a smaller leak diameter. 

5.3.3 Verify Pipeline Layout 

After creating your scenario, select Scenario menu\Verify Layout (or the Network Check button 
on the toolbar). This checks a number of potential problems in the network layout, such as: 

 Missing or invalid object parameters, 
 Outlet point connected to more than one in-coming branch, 
 Pipeline segment shorter than depth difference between endpoints, 
 Maximum number of objects exceeded (100 pipeline segments, 5 junction, 10 

segments per junction), and 
 More than one leakage point found. 

In general, these messages are self explanatory, and lead the user quickly to the problem area. If 
the “valid network” message appears one can continue with the analysis. Otherwise the message-
box identifies the problem. 

Shortcut: Select Calculate Discharge from the Scenario menu (or use the Worst Case discharge 
button on the toolbar). This automatically runs the Verify Layout test prior to estimating the 
discharge for the given scenario. 

5.3.4 Gas Composition 

The property of the gas in the pipeline is specified on a compositional basis using WCDgas’s 
“Scenario->Gas Composition” menu item. The available components include nitrogen, carbon 
dioxide, hydrogen sulfide and hydrocarbon components from C1 to C10. Figure 5.5 provides an 
example gas composition. The user enters the Mol% value for each component present in the 
gas. The total mole fractions must sum to 100%. The gas composition is entered and stored for 
each individual scenario. 
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5.3.5 Discharge Setup 

Optional discharge model parameters can be entered in the Scenario->Discharge Setup menu 
item. These input items can be left blank for normal simulations and are provided for advanced 
model users. 

Figure 5.5: Example Gas Composition 

5.3.6 Nearfield Setup 

The Scenario-> Nearfield Setup menu is used to provide the necessary input information for the 
modeling of the gas rise from the release point at the pipeline to the water surface. The water 
temperature and ”Output to OCD/5” air emission model are the two boxes of primary concern in 
this dialog. The water temperature is entered for the location of the leakage point. The box 
selecting output to OCD/5 should be selected if atmospheric dispersion modeling of the gas at 
the water surface is of interest following the simulation. The discharge start date and time of day 
are not critical data entry items in the present model configuration and can be left to the default 
values. The mass rate smoothing distance can be modified if the mass gas flow rate at the surface 
is not uniform otherwise the default value of zero should be used. 

The algorithms used to predict the behavior of the gas as it rises to the surface are described in 
detail in Appendix B. 
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The Release module must be run before the Near Field module, since the latter uses results from 
the former to compute the timing, rates, and boiling zone of gas at the sea surface. To set up the 
Near Field module, select the menu item Scenario, Near Field Setup (Figure 5.6). 

Figure 5.6 Near Field setup dialog box.
 

Description of entries in Near Field Setup Dialog shown in Figure 5.6:
 
 Water temperature: This is the temperature of the sea water at the location of the leakage 

point. 
 Mass rate smoothing distance: The output can be averaged over several samples (or 

successive time steps) to dampen some of the artifacts that can occur when the input data 
to the Nearfield Module becomes very noisy (“ripples” in the curves, for instance). Note 
that this “input” is equivalent to the “output” or result produced by the preceding Release 
Module. Using a value of 3, for example, means that the averaging at each point in time 
will consider 3 points before and 3 points after the current sample, a total of 7 point to 
average each point in the output time series. 

 Output to OCD/5 air emission model: This is optional, but if used it will produce an extra 
text output file (.DAT) that can be used by the OCD/5 atmospheric dispersion model. A 
starting date and time (using UTC time zone) is specified to correspond to the first time 
that gas was observed to emerge at the surface. This is used to produce the corresponding 
timestamps in the .DAT file. 

5.4 Discharge Calculation 
The gas release predictions are initiated using the Scenario->Calculate options after the pipeline 
network has been established and the gas composition entered. The discharge of gas from the 
pipeline rupture and the movement of the gas from the rupture to the surface both can be 
modeled independently using the “Calculate Discharge” and Calculate Nearfield” options in 
sequence. Since both models complete their calculations quickly it is more efficient in most 
cases to simply use the “Calculate All” option that automatically runs the two processes in 
sequence. The algorithms used to predict the behavior of the gas as it exits the pipeline puncture 
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are described in detail in Appendix A. The algorithms used to predict the behavior of the gas as it 
rises to the surface are described in detail in Appendix B. 

5.5 View Simulation Results 

Once the scenario has been completed the results can be viewed using the main menu “Result” 
dialogs. A Discharge Summary similar to Figure 5.7 automatically appears at completion of the 
discharge calculation (if this option is selected in the main menu Options dialog), and is also 
accessible via the Result menu. This summarizes the gas flow characteristics at the rupture 
location. 

Figure 5.7 Sample Discharge Summary Report 

Time series plots of the gas discharge characteristics at the rupture location and at the water 
surface can be generated using the “Results->Release Plots” and “Results->Nearfield Plots” 
options. In each of these options several variables can be selected for plotting using the selection 
dialog at the top of the plot. Figure 5.8 is an example plot of gas release at the leak or rupture 
location. 
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The variables that can be plotted at the discharge point include: 
 Accumulated Mass 
 Total Mass Flow Rate 
 Gas Mass Flow Rate 
 Oil Mass Flow Rate 
 Gas Flow Rate at Standard and Outlet Conditions 
 Oil Flow Rate at Standard and Outlet Conditions 
 Pressure and Temperature at the Rupture 
 Pressure at the Pipeline Inlet and Outlet 
 Total Mass Flow Rate at the Pipeline Outlet 

Time series results that can be plotted from the Nearfield module are: 
 Accumulated mass surfaced (kg) 
 Vertical velocity of gas at the surface (m/s) 
 Radius of gas bubble plume at the surface (m) 
 Gas rise time rupture to surface(s) 
 Gas mass flow rate at surface (kg/s) 

Figure 5.8 Example Plot of Gas Release at the Rupture Location 
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6 Atmospheric Dispersion Modeling 

6.1 Background 

The Offshore and Coastal Dispersion Model (OCD) developed for MMS in the late 80’s and 
early 90’s has been adapted for use in this project. This model is currently the MMS sanctioned 
atmospheric dispersion model (Herkhof, 2008. pers. comm.). Modifications to the model have 
been implemented to improve its data input and output components. Version 5 of the model 
(OCD/5) was downloaded from the US EPA web site for use in this project 
(http://www.epa.gov/scram001/dispersion_prefrec.htm). The source code was modified and 
recompiled as described in Appendix C and as such the version of OCD delivered with this 
report should be used only for the pipeline discharge application unless tested for other uses. A 
users manual for the OCD/5 software also was delivered with the final project deliverables. 

6.2 OCD Implementation 

The OCD is a complex model that requires the setup of a geographic database, extensive over­
land and over-water meteorological data, pollutant emissions data, source and receptor input 
data. The following describes how this model has been implemented for the modeling of sub sea 
natural gas pipeline accidental releases in the Pacific and Gulf regions of the United States. As 
users become familiar with the software they may wish to explore the features of OCD/5 in more 
detail than that provided here. Basic help documentation is included with the software and digital 
versions of the users manuals and guides were provided with the final project deliverables to 
assist users in expanding their understanding and use of the software. The primary goal of the 
information provided in this report is to guide the user in the basic use of the model using a 
number of pre-set release scenarios. 

6.3 Software Installation Instructions 
The OCD/5 software is installed using the Setup.exe file present in the subfolder 
1OCD5setupDirectory. Detailed instructions for installing, removing and running all of the 
software components delivered in this project are provided in Appendix E. 

6.4 Getting Started 

Once the software has been installed start OCD/5 using the on-screen icon or by running the 
program OCDMENU.exe from its folder in Windows Explorer. Using the main menu File -> 
Open option select either the GOMEX.DAO or PACIFIC.DAO files. These are pre-defined 
geographic study areas within the Gulf of Mexico and Pacific regions for use in the natural gas 
pipeline release modeling. Other regions or sub regions can be established in the future as 
required. A number of data input variables and program settings have been stored in these pre­
defined “study areas”. By clicking on the main menu “Input” option a number of sub-selections 
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are made available. The “Sequential “ sub-option is used when the user wants to enter a complete 
new set of inputs. Rather than review the Sequential option we will look at each sub-menu item 
individually. The following “screen captures” introduce the user to the input data necessary for 
the pipeline release modeling for the nine available input categories. 

6.4.1 OCD/5 Input Screens 

6.4.1.1 Run Information (Figure 6.1) 

Figure 6.1 OCD/5 Run Information Input Dialog 

The three title lines in Figure 6.1 are input to differentiate the model results from other 
simulations. Any text information can be entered here to describe the simulation. 

The Run Period Definition is used to identify the starting hour, day and year of the gas discharge. 
 The starting year data for must match the over-land and over-water meteorological data 

files entered elsewhere. This input is not Y2K compliant but the two digit specifications 
such as 99 for 1999 or 04 for 2004 are valid entries. 

 The starting hour cannot be such that the simulation period extends into the next days 
data. For example, if the length of run is 4 then the Starting hour must be 20 or less. 

 The length of run must match (or at least not exceed) the number of hourly emission data 
entries in the emissions.dat file entered elsewhere. 

 The length of averaging period should be kept at 1 hour for this application. 

For the sample study areas establish for this project the conversion factors should be l. 
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Study Area
Latitude 1

(Domain Y)
Latitude 2

(Domain Y)
Longitude 1
(Domain X)

Longitude 2
(Domain X)

# X
Grids

6.4.1.2 Model Domain (Figure 6.2) 

Figure 6.2 OCD/5 Model Domain Information Input Dialog 

The Figure 6.2 dialog is used to enter the land and water boundaries over the extent of the study 
area of interest. The longitude and latitude extents of interest and the number of grid lines in the 
X and Y directions are entered and the MAKEGEO button is pressed to develop the internal 
geographic land/water boundary dataset. The dataset uses an internal X Y coordinate system that 
is used to display the land/water boundary and for the entry of spill source and pollutant receptor 
locations that will be described later. Longitudes and latitudes of these receptors and sources 
have to be manually converted to the internal XY coordinates prior to entry. This step has 
already been completed and stored in the GOMEX.DAO and PACFIC.DAO files and should not 
be repeated unless a new study area is being established for other uses. If the MAKEGEO option 
is re-run with different extents any emission source or receptor locations will no longer be valid. 
The latitudes and longitudes in degrees and grid numbers used in the pre-defined areas are shown 
in Table 6.1 along with the corresponding Domain X & Y values in kilometres. 

Table 6.1 Model Domains for Sample Study Areas 
# Y 

Grids 
GOMEX 29 (0.0) 31 (218.3) 88 (196.8) 90 (0.0) 120 120 
PACIFIC 33 (0.0) 35.5 (287.7) 118 (313.5) 121.5 (0.0) 120 120 

Once the domain extents have been established the X Y coordinate ranges can be viewed using 
the “Display Map of Shoreline” option described elsewhere. 
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6.4.1.3 Sources (Figures 6.3 and 6.4) 

Figure 6.3 OCD/5 Gas Source Information Input Dialog 

Because the Point Source type generates higher near source concentration estimates it should 
generally be selected for this modeling application to generate conservative concentration 
estimates. 

The pollutant type selected should be “Other”. 

The “Read Hourly Emissions from EMIS.DAT” box in the dialog shown in Figure 6.3 should 
always be checked. The WCDgas pipeline release model is used to generate the natural gas 
emissions data files prior to implementing the atmospheric dispersion model in this application. 

The “Specify Significant Sources Box” must be checked and the source of interest in the 
implementation should be highlighted. Only one point source should be selected for each 
simulation due to the data output graphing modifications implemented in this version of OCD/5. 

Important Note: It appears that this data entry occasionally is corrupted and an error message 
indicating that the number of significant sources is incorrect will be issued during an OCD/5 run. 
If this occurs re-visit this dialog and de-select the Specify Significant Sources box and then re­
select it. Then de-selecting the source from the named list so the number of sources reverts to 
zero, then re-select the source from the list to re-set the number of sources to 1. This should 
remedy the problem. 
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New sources are defined by clicking on the “Define Sources” button that brings up the dialog in 
Figure 6.4. For the gas pipeline discharge application only one source can be defined in the list in 
the Figure 6.4 dialog at a given time even if only one significant source is selected in the Figure 
6.3 dialog. If more than one source is defined in the Figure 6.4 dialog, an error is encountered 
and OCD/5 does not run to a successful completion. 

Figure 6.4 OCD/5 Gas Source Information Input Dialog 

The X and Y coordinates, height of Stack-Top, Stack Gas Temperature and Stack Gas Exit 
Velocity need to be entered for each Source Name specified. The positional coordinates must be 
entered in Study Domain units. A manual conversion of Longitude and Latitude values must be 
made. The Longitude/Latitude and Domain X/Y equivalents in Table 6.1 can be used to convert 
Longitude and Latitude data for the two sample study areas provided. The stack height must be 
greater than 0.1 m so a value of 0.11 is entered to represent gas exiting at the water surface. The 
stack gas exit velocity of 0.01 m/s is entered to give the gas low momentum at the water surface 
that results in conservative gas concentration estimates. The Stack Gas Temperature should 
reflect the surface water temperature at the site of the gas source since the gas temperature 
should be close to water temperature at exit to the atmosphere. All other values are not used in 
this open-water analysis and zero values can be entered for them. There appears to be a ‘bug’ in 
the OCD/5 software. If more than one source is defined in the dialog of Figure 6.4 an error is 
encountered and the simulation will not run to completion. 
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6.4.1.4 Dispersion (Figure 6.5) 

Figure 6.5 OCD/5 Dispersion Options Input Dialog 

The Use Terrain Adjustments, Use Gradual Plume Rise and Use Buoyancy-Induced Dispersion 
options in the dialog of Figure 6.5 can be checked for this modeling. For the sample scenarios 
simulated in this project the natural gas disperses to below significant concentrations within at 
most a few kilometres from the source so in all cases the pollutant does not reach the water land 
boundary. As such, the Use Terrain Adjustment Option is really not necessary in the cases 
modeled. 

6.4.1.5 Receptors (Figures 6.6 & 6.7) 

Figure 6.6 OCD/5 Receptor Options Input Dialog 

The selection of Polar receptors in the dialog shown in Figure 6.6 is recommended for this 
application. The plotting function implemented at the end of each simulation may not function 
properly if other receptor schemes are implemented. The locations of the receptors are entered by 
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manually entering the data and using the “Define Polar Receptors” button that brings up the 
dialog shown in Figure 6.7. 

Figure 6.7 OCD/5 Receptor Options Input Dialog 

The Center of Rings should be the same as the XY location of the emissions source that was set 
in the Sources dialog of Figure 6.4. Because the natural gas diffuses to below significant 
concentration quite rapidly receptor rings should be established in close proximity around the 
source. In the sample shown in Figure 6.7 ten rings have been entered at 0.5 km radial 
increments from the source out to 5 km from the source. If these receptors were to reach land 
then elevations should be entered for each of the receptors so land influence can be taken into 
account in the dispersion modeling. For the offshore cases being considered in this report land 
elevations were not required since the receptors are all over water and the gas concentration 
dropped to below significant levels well within the bounds of the receptors. 

29
 



6.4.1.6 Meteorology (Figures 6.8 to 6.10) 

Figure 6.8 OCD/5 Meteorological Input Dialog #1 

The “Source of Overland Meteorological (Met) Data” in the dialog of Figure 6.8 should be 
specified as “ASCII, in Separate PCRAMMET File”. EPA and others commonly use this file 
format for Met data. A recent study (Douglas, 2008) completed for the MMS Gulf of Mexico 
Region (MMS GOM) developed OCD/5 compatible over-land (LMET) an over-water (WMET) 
meteorological data files for five full years (2000 to 2004) and these data sets are directly 
compatible with the version of OCD/5 delivered in this contract. A minor modification was made 
to the OCD/5 program to allow the model to accept the full Y2k compliant year data present in 
the headers of the LMET data sets developed under the MMS GOM contract. If a non-modified 
version of OCD/5 is used with these data files the year designation in the file headers have to be 
manually edited to 2 digit, non Y2k compliant dates before the model will run successfully. 

The Surface and Upper Air Station Identifier codes entered in this dialog (Figure 6.8) must 
match those present in the PCRAMMET (LMET) data file header or the program will not run to 
completion. The years entered for the Surface and Upper Air Data must also match those present 
in the LMET header. These years must be entered in 2 digit codes in the dialog entry, not in Y2k 
compliant form. The data entered in the example of Figure 6.8 is for the year 2004. 

For MMS regions where pre-developed LMET and WMET data are not available the user will 
have to develop the files using available MET data from several sources and tools designed to 
generate the files in the appropriate format. Detailed discussions of the available data sets and the 
methods used to generate the LMET and WMET data files are provided in Appendix D. 

The Met Data Options and Site Characteristics and Instrumentation Buttons in Figure 6.8 are 
discussed with reference to Figures 6.9 and 6.10, respectively. 
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Figure 6.9 OCD/5 Meteorological Input Dialog #2 

The options shown in Figure 6.9 must be selected when using the LMET and WMET data files 
available from the recent MMS GOM region study detailed above. When developing datasets 
using the methods described in Appendix B the “Over-water Humidity” option should generally 
be specified as Dew Point Temperature and the “Water Surface Temperature” option should be 
specified as Water Surface Temperature. These are the settings used in the example scenarios 
developed for the PACIFIC.DAO dataset delivered with this report. 

The Site Characteristics and Instrumentation dialog of Figure 6.10 must be populated with sensor 
height information from the weather station or buoys from which the LMET and WMET data 
were obtained. The surface roughness value of 0.0001 should be used for all modeling over 
water surfaces. EPA recommends a “Minimum Miss Distance” of 10 m. The approximate 
latitude of the pollutant source is entered in the “Latitude of Source Region”. 
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Figure 6.10 OCD/5 Meteorological Input Dialog #3 

6.4.1.7 Chemical Transformations (Figure 6.11) 

Natural gas will not decay via chemical transformation so the dialog shown in Figure 6.11 is left 
inactive. 

Figure 6.11 OCD/5 Chemical Transformation Input Dialog 
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6.4.1.8 Output Options (Figure 6.12) 

Figure 6.12 OCD/5 Output Options Dialog 

The three items checked in Figure 6.12 should be selected for output. The hourly input emissions 
source data and final receptor concentration data will be recorded in the main Output Listing File 
for the scenario when the first two items are checked. It is essential to check the “Create 
Summary Output File Called “EXTRA.OUT” for a plot of the final dispersion prediction. The 
other data output options may be useful in some instances to better understand how the final 
results were arrived at. An automatic plotting of the dispersion predictions has been implemented 
in the version of OCD/5 delivered for this project to provide a more immediate and visual 
presentation of the results. As mentioned above, the plotting procedure uses the “EXTRA.OUT” 
summary data file as its source of information. A popular free-ware plotting package called 
GNUPLOT has been interfaced with OCD/5 to enable this plotting feature. 

33
 



6.4.2 OCD/5 Run Gas Dispersion Simulation 

There is only one sub-option in the Run dialog of OCD/5. The input requirements for this dialog 
are discussed using Figure 6.13 as a guide. 

Figure 6.13 OCD/5 Scenario Run Dialog 

The Control File is automatically established when the study area is opened immediately after 
starting the OCDMENU software. 

All simulations should be run using the Regular Run setting. 

The ASCII Over-water and Over-land data files must hold data that matches the information 
entered in the dialog shown in Figure 6.8 and have data for the dates specified in the Figure 6.1 
dialog. The descriptive information entered in the dialogs of Figures 6.9 and 6.10 should also 
pertain to the data in these two files. 

The pipeline gas release model ‘WCDgas’ generates the “Hourly Emission File”. This file will 
have one line of data for each hour or sub-hour of natural gas emissions. The number of lines in 
the file must match or exceed the “Length of Run” information entered in the dialog of Figure 
6.1 or an “end of file” error will terminate the simulation. 

The Log file provides a record of the simulations that have been completed. This file is appended 
to each time a run is completed. The filename does not have to be changed unless a clean record 
of simulations is wanted. 
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The Output Listing and Secondary Output File Names should match the Hourly Emissions name 
so a triplet of files is maintained for each simulation. The file extensions of dat, out and txt are 
not mandatory but a consistent naming convention will help organize the simulation results. 

Once the fields are populated the RUN button initiates the air dispersion modeling. At the end of 
the simulation a plot of the results is automatically generated through a GNUPLOT script file. 
The plot includes the Lower Explosive Limit (LEL) concentration for natural gas and a 3-D 
representation of the predicted gas concentration based on the data provided in the Secondary 
Output file. The plot view can be manipulated by right clicking on the plot and dragging the view 
orientation to the view of interest. The GNUPLOT “Pause” dialog can be dragged to the side for 
an unobstructed view of the plot. The plot view is terminated by clicking the Pause button. This 
returns the user to OCDMENU. Archived simulations can be plotted independently from OCD/5 
using the ‘Replot’ batch file. Sample views of a single simulation are shown in Figures 6.14 
through 6.16. 

Figure 6.14 Example GNUPLOT Output of OCD/5 Modeling Results 
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Figure 6.15 Example GNUPLOT Output of OCD/5 Modeling Results 

Figure 6.16 Example GNUPLOT Output of OCD/5 Modeling Results 
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7	 Modeling Results: Example Gas Pipeline Rupture 
Scenarios 

7.1 Modeling Procedure 
The general procedure for modeling a gas pipeline release from the sea floor to final atmospheric 
dispersion using the provided software is as follows: 

1.	 Build the pipeline network and enter the appropriate pipeline operating parameters and 
leak characteristics within WCDgas or select a previously defined network. 

2.	 Use the “Calculate All” option in WCDgas to simulate the sub sea and near field gas 
behavior. Make sure the option to generate the emissions.dat file is selected prior to 
running the WCDgas simulation. 

3.	 Open the OCDmenu software and select the study area of interest (PACIFIC.DAO or 
GOMEX.DAO). 

4.	 Enter a “Length of Simulation” in the Run Information dialog that matches the number of 
hours of gas release shown in the emissions.dat file created by the WCDgas simulation of 
step 2. Or specify a 1 hour length to generate the worst case plot for a guillotine type 
rupture. Also specify the date and time of day for the dispersion modeling in this dialog. 

5.	 Specify the Wmet, Lmet and hourly emissions input files and the various output files 
appropriate for the release location and timing in the “Run OCD” dialog (see section 
6.4.2). 

6.	 Run the OCD/5 simulation and the 3-dimensional plot of the surface gas concentration 
will automatically be generated along with numerous supporting data files. 

7.	 Note: the WCDgas and OCD/5 programs are standalone applications and can be run 
independent of each other in any order so long as the appropriate data files are present for 
their proper operation. The emissions.dat file generated by WCDgas is used by OCD/5 as 
its gas source term and is the link between the two applications. Once the emissions file 
is generated by WCDgas the OCD/5 model can be run multiple times without re-running 
WCDgas to investigate different atmospheric conditions etc. 

7.2 Description of Example Scenario Input Files 

The example gas pipeline information provided in section 3 has been used to develop 8 example 
gas pipeline rupture scenarios for the Pacific Region. Six of the scenarios are guillotine pipeline 
breaks and two are one inch diameter punctures or failures. The WCDgas input file names 
assigned to these scenarios are provided in Table 7.1. The Wmet, Lmet Hourly Emissions, and 
Secondary Output Data filenames used in the example simulations or generated by OCD/5 are 
also included in Table 7.1. When operating in the Pacific Region choose the PACIFIC.DAO 
study area file when the OCD Main Menu first appears (Using the File->Open option or by 
selecting a recently opened file from the list at the bottom of the “File” submenu options). The 
overland meteorological data used in the example scenarios (Lmet91) were derived from 1991 
data sets using the procedures outlined in Appendix D. The 1991 overland data was the most 
recent available for the Pacific Region. It is appropriate to note that OCD/5 predicts the 
dissipation of the gas cloud to below hazardous conditions while still over water in all 
simulations completed in this study. The overland Met data is therefore not critical in the air-side 
dispersion assessments completed for this project. Met data for other years can be developed 

37
 



Scenario Description
(pipeline diameter, puncture
depth and hole size)

WCDgas
Input

Filename
(.wcd)

Hourly
Emissions
Filename

(.dat)

Wmet
Filename

(.dat)

Lmet
Filename

(.dat)

using the procedures provided in Appendix D and substituted for the files used in the provided 
examples. The Wmet data file named B4602391.dat was delivered with the project to work in 
conjunction with the 1991 Lmet data file. The first six characters in this file name describes the 
buoy number from which the data was extracted and the last two characters the year that the data 
was recorded. The OCD/5 model uses an over-water humidity term that is specified in the 
meteorology dialog of Figure 6.9. The actual humidity, wet bulb temperature or dew point 
temperature must be available. Most of the buoys in the Pacific region do not record these data. 
Buoy 46023 does gather dew point temperature so it was selected to provide example data for 
this project. The data sets developed for the Gulf of Mexico provide a direct measure of Relative 
Humidity. 

When operating in the Gulf of Mexico (GOM) region open the GOMEX.DAO study area file. 
The Lmetga04 and Wmetga04 meteorological data files shipped with the project deliverables 
were used in the OCD/5 simulations in the Gulf of Mexico. These data sets were acquired from 
the MMS Gulf of Mexico Regional office as described in Appendix D. Any of the gas emissions 
files developed for the Pacific Region can be used in the GOM Region in lieu of GOM specific 
pipeline release data. 

Table 7.1 Example Gas Pipeline Rupture Simulation Input and Output Data Files 

OCD/5 Input Files 
Secondary 

Output 
Filename 

(.txt) 
12 inch, shallow, guillotine Pac12shG Pac12shG B4602391 Lmet91 Pac12shG 
12 inch, deep, guillotine Pac12dpG Pac12dpG B4602391 Lmet91 Pac12dpG 
12 inch, shallow, 1” puncture Pac12sh1 Pac12sh1 B4602391 Lmet91 Pac12sh1 
12 inch, deep, 1” puncture Pac12dp1 Pac12dp1 B4602391 Lmet91 Pac12dp1 
24 inch, shallow, guillotine Pac24shG Pac24shG B4602391 Lmet91 Pac24shG 
24 inch, deep, guillotine Pac24dpG Pac24dpG B4602391 Lmet91 Pac24dpG 
36 inch, shallow, guillotine Pac36shG Pac36shG B4602391 Lmet91 Pac36shG 
36 inch, deep, guillotine Pac36dpG Pac36dpG B4602391 Lmet91 Pac36dpG 
36 inch, shallow, guillotine Gom36shG Gom36shG Wmetga04 Lmetga04 Gom36shG 
36 inch, deep, guillotine Gom36dpG Gom36dpG Wmetga04 Lmetga04 Gom36dpG 

7.3 WCDgas Simulation Results 

The detailed results for the in-water gas behavior predictions for each of the simulations can be 
viewed by opening each scenario individually in WCDgas. Table 7.2 provides a summary of the 
key “in-water” simulation results for the example scenarios. 
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Scenario

Total
Release
Time

at Leak
(min)

Time for
90% of Gas

to Exit at
Surface
(min)

Maximum
Hourly Gas
Flow Rate
At Surface

(g/s)

Bubble
Plume

Radius at
Surface

(m)

Bubble
Rise
Time
Range

(s)

The total release times shown reflect the time taken for all of the gas to exit the pipeline at the 
puncture location. The gas flow slows significantly during the latter stages of the release so for 
the purposes of surface air modeling it is instructive to know the time period over which the bulk 
of the gas exits the water surface. Column three shows the time required for 90% of the gas to 
exit at the water surface. The OCD air dispersion model accepts 1-hour minimum gas source 
durations, since it was not originally designed for use in short duration pollutant releases. A 
worst-case gas source term is calculated from the WCDgas results for each scenario for use as 
input to OCD/5. If the time for 90% of the gas to exit the water surface is less than 1 hour the 
total gas mass discharged over the entire release is divided by the time taken for 90% of the gas 
to exit at the surface to determine this rate. If the gas exit at the surface takes longer than 1 hour 
the quantity exiting the surface over each full hour is divided by an hour to determine the hourly 
gas source rates. The maximum hourly rates calculated for each scenario using this logic is 
provided in column 4 of Table 7.2. The *.dat files generated by WCDgas contain the detailed 
surface gas source information that is subsequently used by OCD/5. The air dispersion model 
results will be conservative for those scenarios where most of the gas exits the surface in 
considerably less than an hour since in these cases longitudinal dispersion of the gas will be 
occurring and this process is not considered by OCD/5. The bubble plume radius, gas rise time 
and bubble rise velocity data provided in Table 7.2 reflect the results from the beginning of the 
release (larger radius, short rise times and high velocities) to the point where about 90% of the 
gas has been discharged and the flow is significantly reduced (smaller radius, larger rise times 
and slower velocities). 

Table 7.2 WCDgas Results Summaries 
Bubble 

Rise 
Velocity 
Range 
(m/s) 

Pac12shG 12 5.2 264,677 20 to 40 10 to 40 2 to 12 
Pac12dpG 22 13.0 93,874 30 to 80 50 to 300 1 to 8 
Pac12sh1 348 212 9,533 17 to 22 30 to 60 1.7 to 3.3 
Pac12dp1 228 160 9,264 40 to 45 180 to 220 1.25 to 2.1 
Pac24shG 254 114 521,039 20 2 to 10 5 to 20 
Pac24dpG 98 64 339,409 150 to 250 300 to 800 1.5 to 8 
Pac36shG 38 18 1,592,500 20 to 45 2 to 6 10 to 40 
Pac36dpG 72 64 277,017 150 to 250 300 to 800 1 to 6 

7.4 OCD/5 Simulation Results 
The OCD/5 input files shown in Table 7.2 were used in the OCD/5 Run dialog to generate the air 
dispersion estimates for the example gas release scenarios. The runs were completed for three 
different time periods to show the effects of differing winds on the air dispersion results. The 
simulations were completed in calm winds of approximately 1 m/s (Julian day 6, starting at hour 
7), 5 m/s (Julian Day 31, starting at hour 22) and 10 m/s (Julian Day 50, starting at hour 11). All 
scenarios were run using the B4602391 Wmet dataset. All runs were completed using a point 
source designation for the gas to provide conservative estimates of downwind gas 
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Approximate Dista
Below the LoScenario

1 m/s Wind Speed 5 m/s Wind Speed

concentrations. The distances downwind from the source where gas concentration dropped below 
the lower explosive limit (LEL) of 35 g/m3 are reported in Table 7.3 for the three wind speed 
conditions. These data were interpolated from the graphs generated at the end of the OCD/5 runs. 
The graphs can be re-generated by opening a command window in the OCD/5 directory and 
using the “replot filename.txt” command, where the filename is the name of the secondary output 
filename from the OCD/5 simulation (see last column of Table 7.1) 

Only one of the scenarios resulted in explosive gas concentrations beyond 1 kilometer from the 
discharge location. For most of the scenarios explosive gas concentrations only will exist inside 
500 meters of the release location. It is important to re-state that two modeling input conditions 
used in this modeling will result in conservative gas concentration estimates. The OCD/5 model 
does not account for downwind dispersion as it is usually used for longer-term gas releases. As a 
result the downwind concentrations for the short events will be over-estimated. The specification 
of a point source of gas in these situations, where the gas will rise from the water surface over 
areas with radii of between 20 and 250 m (see Table 7.2), results in an over-estimation of the gas 
concentrations. The Pac36shG scenario has been re-run using a gas release diameter of 60 meters 
and the distance to LEL concentration dropped to 800 m from the 1100 m distance determined 
when a point source was used. If a 90 m diameter gas source (the predicted surface bubble plume 
diameter during the peak gas flow period) is used in this scenario the predicted gas 
concentrations drop below the LEL in less than 250 m from the source. 

Table 7.3 OCD/5 Example Scenario Results Summary 
nce Downwind where Gas Concentration Drops 
wer Explosive Limit for Natural Gas (m) 

10 m/s Wind Speed 
Pac12shG 300 300 300 
Pac12dpG < 250 < 250 < 250 
Pac12sh1 < 250 < 250 < 250 
Pac12dp1 < 250 < 250 < 250 
Pac24shG 425 475 450 
Pac24dpG 350 400 375 
Pac36shG 900 1100 750 
Pac36dpG 300 375 350 
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8 Model Sensitivity Testing 

The purpose of the sensitivity analysis is to identify the input parameters that are essential to the 
successful modeling of a sub sea gas pipeline release from a guillotine break and those that are 
not as critical to a reasonable prediction of the fate of gas in such an event. 

8.1 Pipeline Gas Release Modeling: WCDgas 

There are several data input requirements necessary when defining the gas pipeline release 
scenario in WCDgas. Table 8.1 lists the inputs and ranks their general significance with respect 
to the final accuracy or relevance of the final modeling results. The items deemed essential are 
the primary parameters that describe the basic pipeline and the puncture: its length, diameter, 
operating flow rate and pressures, the time to stop the pipe flow in the event of an accident and 
the diameter of the puncture. If reasonably confident values for these parameters are not known 
then the model outcome will not reflect the situation at hand. The best available information for 
these parameters must be used in the modeling session. The input variables tagged with the 
question marks in the “Significant” category have been investigated in a sensitivity analysis to 
determine how important their contribution is to the final gas release process and thus give the 
model user some guidance as to how precise these input data need to be for reasonable modeling 
outcomes. 

The representative pipeline release scenarios developed with MMS have been used as the basis 
for this sensitivity analysis. The basic pipeline and rupture conditions identified in these 
scenarios (see section 3) have been used as the starting point for the assessment and the 
remaining input variables have been varied one at a time over a range of reasonable values to 
determine their significance on the modeling results. The maximum hourly emission rate of gas 
at the sea surface has been used to characterize the model output variability with these input 
changes. One of the primary goals of the modeling is to identify maximum possible hazard zones 
at the sea surface from the pipeline discharges so reasonable worst-case results (maximum 
hourly surface emission rates as defined in section 7.3 are of primary interest. Guillotine breaks 
have been used in all modeling as this generates the maximum possible flows from the pipeline. 
Preliminary modeling has indicated that punctures in the center of the pipeline segment (distance 
of puncture from upstream end) result in the maximum emission rates at the surface because the 
gas is exiting from both ends of the pipeline over the full duration of the discharge. Center 
pipeline releases have thus been used during the sensitivity modeling for other variables. 
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Known I
Input Variables

Essential Significant

Table 8.1 WCDgas Data Input Requirements 
mportance of Variable Prior to Sensitivity Testing 

Minor/No Influence 
Pipeline Segment 

Label X 
Length X 

Diameter X 
Roughness ? 

Heat Transfer Coeff. ? 
Ambient Temperature ? 

Inlet 
Label X 
Depth ? 

Gas Flow Rate X 
Temperature ? 

Closing Time X 

Outlet 
Label X 
Depth ? 

(operating) Pressure X 
Closing Time ? 

Puncture / Leakage 
Distance from upstream end ? 

Diameter X 
Water Depth ? 
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8.1.1 Pipeline Roughness 

Pipeline roughness values are typically 10x10-5 ft (30 microns) or smaller (Morten Emilsen pers 
comm. 2009). Base pipeline release scenarios for the 36 inch and 12 inch pipelines have been 
modeled using 1x10-5 ft, 10x10-5 ft and 100x10-5 ft roughness values. The results of this 
sensitivity assessment are plotted in Figure 8.1. The maximum hourly emission rate estimates at 
the surface changed by less than 3% from the typical roughness value. Based on this assessment 
it is recommended that a pipeline roughness value of 10x10-5 ft (30 microns) be used in 
simulations when a specific roughness for the pipeline is not available. 

WCDgas Sensitivity to Pipeline Roughness 
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Figure 8.1 WCDgas Sensitivity to the Pipeline Roughness 
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8.1.2 Heat Transfer Coefficient (k) and Inlet Gas Temperature 

Unburied and un-insulated pipelines have heat transfer coefficients on the order of 10 BTU/hr ft2 

°F (57 W/m2 °C) and insulated or buried pipelines have heat transfer coefficients of between 0.5 
to 2 BTU/hr ft2 °F. The same base scenarios used for the pipeline roughness sensitivity modeling 
have been used to determine the sensitivity of the model results to the heat transfer coefficient 
(using the 10x10-5 ft roughness value) with the exception that the inlet gas temperature has also 
been varied to establish the importance of this input variable on the model results. Gas inlet 
temperatures of -4 and 48 F were used. Heat transfer coefficients of 0.5, 2, 10 and 30 BTU/hr ft2 

°F have been used in the assessment. The results shown in Figure 8.2 indicate that the inlet gas 
temperature has little influence on the initial high flow episode in the guillotine type break 
scenarios being considered. The heat transfer coefficient has considerable impact on the emission 
rate results from the model for the 36 inch pipeline scenario considered, especially for the low 
heat transfer situation in the insulated or buried cases. Because of this, the heat transfer 
coefficient value entered should minimally reflect whether the pipeline is insulated/buried or 
simply on the seabed. A heat transfer coefficient of 0.5 BTU/hr ft2 °F should be used for buried 
or insulation pipelines and a value of 20 BTU/hr ft2 °F should be used for non-insulated pipelines 
on the seabed when actual heat transfer coefficients are not available. These inputs will result in 
reasonable maximum surface gas emission rates. If the buried/insulated status of the pipeline is 
not known run the simulation twice with the two default values to determine if there is any 
significant difference in the final model outcome. 

WCDgas Sensitivity to Pipeline Heat Transfer Coefficient & Gas Temperature 
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Figure 8.2 WCDgas Sensitivity to the Pipeline Heat Transfer Coefficient and Inlet Gas 
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8.1.3 Depth of Gas Inlet Into Pipeline 

The 24-inch and 36 inch pipeline base scenarios have been used to test the sensitivity of the 
model results to the gas inlet depth. Inlet depths of 60, 300 and 900 m (approximately 200, 1000, 
and 3000 ft) have been used in the assessment. The depth of the pipeline break has also been 
varied to include near surface breaks (1 m depth) and deep breaks (the same depth as the gas 
inlet depth). Figure 8.3 shows the results of this assessment. If the break is at the surface the inlet 
gas depth has little influence on the surface emission rate. If the break is at depth then the inlet 
gas depth can have a significant influence on the maximum surface emission rate, especially for 
the larger pipeline scenario. 

WCDgas Sensitivity to Pipeline Inlet Depth 

0 

500 

1000 

1500 

2000 

2500 

3000 

0 500 1000 1500 2000 2500 3000 

T
h

o
u

s
a
n

d
s
 

Inlet Depth (ft) 

S
u

rf
a
c
e

 E
m

is
s
io

n
 R

a
te

 (
g

/s
)

36" deep release 

36" shallow release 

24" deep release 

24" shallow release 

Figure 8.3 WCDgas Sensitivity to the Pipeline Gas Inlet Depth 

45
 



8.1.4 Pipeline Outlet Depth and Outlet Closure 

In this assessment it was assumed that the pipeline outlet would always be on land at or above 
the water surface. Three outlet “depths” were evaluated: 0, 164 and 1640 ft above sea level (0, 
50, 500 m). The scenarios were run with no outlet closure and with the outlet closed after 2 
minutes. The results of the model runs are shown in Figure 8.4. The results indicate that the 
outlet depth had little influence on the maximum surface gas emission rate and that by closing 
the outlet there was a reduced maximum emission only for the case of the pipeline outlet at water 
level. It is recommended that a zero pipeline outlet depth and no outlet closure be used in 
simulations where specific data are not available. 

WCDgas Sensitivity to Pipeline Outlet Location 
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Figure 8.4 WCDgas Sensitivity to the Pipeline Gas Outlet Depth and Outlet Closure 
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8.1.5 Water Depth at Pipeline Rupture 

The effect of the depth of the water over the puncture location has been investigated using the 
base scenarios with puncture locations at the center of the pipelines and three puncture depths. 
The modeling results are shown in Figure 8.5. As would be expected the results show that the 
water depth over the rupture is important in determining the maximum surface gas emission, 
especially for the larger diameter pipelines and in the deeper water scenarios. The influence of 
the over-water pressure was not significant in the shallower 12-inch pipeline scenario. Based on 
these results it is apparent that a reasonably accurate water depth is a necessary input to the 
model to achieve reasonable results. 

WCDgas Sensitivity to Pipeline Leak Depth 
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Figure 8.5 WCDgas Sensitivity to the Pipeline Rupture Depth 
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8.1.6 Pipeline Ambient Temperature 

In this assessment it was assumed that the pipeline ambient temperature was the water 
temperature at the depth of the pipeline segment. Temperatures of 35, 60 and 85 °F have been 
used in the basic scenarios to assess the impact of this input parameter. It is not reasonable to 
assume that the high water temperatures would exist in the deep water situations but the model 
was run to assess the impact of the full range of temperatures for all three of the base scenarios. 
The results shown in Figure 8.6 indicate that the ambient water temperature does not have a 
significant affect on the release rate of the majority of the gas in guillotine break situations. If the 
ambient water temperature is not known a best guess approach should suffice. Generally use a 
cold-water temperature for deep-water situations (40 °F) and warmer temperatures (50 to 60°F) 
in shallow temperate zone waters. 

WCDgas Sensitivity to Pipeline Ambient Water Temperature 
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Figure 8.6 WCDgas Sensitivity to the Pipeline Ambient Water Temperature 
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Known
Input Variables

Essential
Significance or Default

Value if Applicable

8.1.7 Summary of WCDgas Sensitivity Testing 

The results of the WCDgas sensitivity modeling have been summarized in Table 8.2 to provide 
users a quick guide as to what input data are critical for a precise simulation and what default 
input values can be used if scenario specific data is not available. The best available data must be 
used for those items marked essential in Table 8.2. 

Table 8.2 WCDgas Data Input Requirements Post Sensitivity Testing 
Importance of Variable After Sensitivity Testing 

Minor/No Influence 

Pipeline Segment 
Label X 

Length X 
Diameter X 

Roughness 10x10-5 ft (30 microns) 

Heat Transfer Coeff. 

0.5 BTU/hr ft2 °F 
(buried or insulated) 

20 BTU/hr ft2 °F 
( non-insulated) 

Ambient Temperature 

Not significant- use 
40°F for deep water 

55°F for shallow 
temperate waters 

Inlet 
Label X 

Depth 
Can be significant- use 

best available 
information 

Gas Flow Rate X 
Temperature Not significant 

Closing Time X 

Outlet 
Label X 
Depth Not significant – use 0 

(operating) Pressure X 

Closing Time 
Not significant – do not 

close 

Puncture / Leakage 

Distance from upstream end 

Punctures in pipeline 
center are worst case. 

Punctures close to either 
end result in similar 

rates. 
Diameter X 

Water Depth 

Important especially for 
deep water 

Use best available 
information 
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B4602391 Input Data

Environmental
Condition

Julian
Day

Hour
Sea Wind

Speed
(m/s)

Sea Air
Temp.
(oK)

8.2 Atmospheric Dispersion Modeling: OCD/5 
The primary input variables that could affect the air dispersion modeling results for a given gas 
source rate are the type of source (point or area), and the atmospheric receiving conditions (air 
temperature, wind speed, atmospheric stability etc.). Point sources will generate the highest near 
source concentrations as identified in section 7.4. The gas exit radius is available from the 
WCDgas output so a specific source area is available if less conservative gas concentration 
estimates are of interest. The atmospheric conditions are provided to OCD/5 via the Wmet and 
Lmet data files. For the scenarios modeled in this study the over-water data is more critical since 
the gases disperse to below LEL prior to reaching land in all cases modeled. The B4602391.dat 
Wmet file used in the Pacific study area simulations was sorted by wind speed and air 
temperature to identify minimum and maximum air temperatures for three different wind speed 
conditions (1, 5 and 10 m/s). The Julian days and hours in the day when these conditions 
occurred were identified (see Table 8.3). The OCD/5 dispersion model was executed for each of 
these environmental input conditions using the gas source rate for the Pac36shg spill scenario 
(see Table 7.1) to assess the significance of the receiving environmental conditions on the 
dispersion process. The distance downwind where the gas concentration drops below the LEL is 
recorded in Table 8.3. The mid-range wind speed condition resulted in the longest hazard zone 
likely due to the more stable atmospheric conditions created by the moderate winds. Both the 
light and heavy wind conditions created smaller hazard zones presumably due to unstable 
atmospheric conditions that can arise in either low or high wind conditions. There was only 
about a 1.5 times variation in hazard zone over the range of conditions tested. For conservative 
modeling results it is recommended that simulations be completed in periods of moderate winds 
and temperatures. 

Table 8.3 Inputs to OCD/5 for Sensitivity Assessment 

Distance to 
Gas Concentration 

Below LEL 
(m) 

Low wind / low temp. 75 19 1 287.3 800 
Low wind / high temp. 227 7 1 292.9 750 
Medium wind / low temp. 131 13 5 286.5 1100 
Medium wind / high temp. 255 17 5 290.8 1000 
High wind / low temp. 130 14 10 286.0 800 
High wind / high temp. 267 6 10 291.0 850 
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9	 Environmental, Health and Safety Risks from Sub Sea Gas 
Discharges 

9.1 Environmental Risks 

The overwhelming component in natural gas is methane. Methane is a colorless and odorless gas 
at standard conditions and is listed as non-toxic in hazardous material handbooks (Environment 
Canada 1984) except as an asphyxiant. Little is known about the effects of natural gas on biota in 
marine waters. No references could be found in the literature on the levels of dissolved methane 
or natural gas that might cause lethal or sub-lethal effects on marine biota. The discharges in 
question will be violent, short-lived episodes that see large quantities of large bubbles of gas 
rising quickly from the sea bed to the surface. During the rise the gas bubbles will entrain water 
and generate 1 to 40 m/s velocities in the plume (see Table 7.2). The short rise times and large 
gas bubbles will limit the amount of gas that will dissolve in the water (Leifer 2006). The 
primary mechanisms for impact on marine biota will likely be through entrainment and 
displacement of organisms, turbulence and possibly asphyxiation. The overall impact from a 
single incident would be small, however, due to the short duration of the event and the small 
zone of influence of the spill (the maximum plume diameter at the surface will be on the order of 
two hundred meters). The total quantity of water entrained by each incident will be in the range 
of 107 to 109 m3. This translates to less than a cubic kilometer of water in total that would be 
affected by the release. The impact to the biota within this volume would also likely be minimal 
due to the non-toxic nature of the gas and the small quantity dissolving during the short event. 
The potential risks from displacement and turbulence are not clear. However, the volume of 
water in question is small and the gas discharges should result in negligible impact. 

9.2 Health and Safety 

Natural gas or methane are non-toxic but are asphyxiants with respect to human health. The 
amount of natural gas or methane needed to cause asphyxiation is a considerably higher 
concentration than the lower explosive limit (LEL) for methane (3% by weight or approximately 
35 g/m3) and so the LEL is of primary concern from a health and safety standpoint. The 
conservative air concentration dispersion simulations completed in this study indicate that the 
sub sea gas pipeline releases will generate hazard zones less than 1100 m downwind of the gas 
source for the worst case scenario considered (see Table 7.3). In most instances the explosive 
zone will extend less than 500 m from the source. The guillotine pipeline ruptures modeled will 
also result in short episodes (see Table 7.2) with the entire loss of gas occurring usually in less 
than one hour (with a maximum 4 hour discharge) and the high discharge rate periods with 
maximum hazard zones lasting for even shorter times. The hazard zone will cease to exist prior 
to the loss of the last gas from the pipeline due to the slowing of the gas flow rate at the end of 
the release and the rapid dispersion of the gas in the air. 

Another concern surrounding sub sea gas discharges often expressed by mariners is whether or 
not the gas plume could result in buoyancy loss to the point where a ship would sink if it were in 
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the plume. Studies have been completed to investigate this concern (Milgram 1984 and Hammett 
1985). These studies have shown that the vessels will not sink. It has been shown that the loss in 
buoyancy caused by the rising gas can be overcome by the upward momentum of the plume, the 
significant radial flow of water away from the plume rise location will push vessels away from 
the bubble zone and the bubble rise location is very dynamic due to the plume’s turbulent nature. 
All of these factors eliminate the chance of a vessel sinking due to the presence of the bubble 
plume. 
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Appendix A: Pipeline Rupture Release Algorithm Details 

1 The Peng Robinson Equation of State 

1.1 General 
A compositional model is used to predict the hydrocarbon phase behavior and thermodynamical 
properties. The calculations are based on the concept of an equilibrium constant, K value, 
defined as the ratio of the mole fraction of the component in the gas phase, yi to the mole fraction 
of the same component in the liquid phase, xi. 

y
Ki  i 

xi 

Unlike a single component fluid, a multi component mixture exhibits a phase envelope rather 
than a single equilibrium curve. This implies that pressures and temperatures inside the phase 
envelope, both liquid and gas phases exists in equilibrium. 

The software requires a compositional input describing the hydrocarbon fluid and uses the Peng-
Robinson Equation of State (EOS) to calculate the required fluid properties as functions of 
pressure and temperature. The equation of state is a thermodynamic equation describing the state 
of matter under a given set of physical conditions. The compressibility factors and phase 
distributions are determined from the EOS and the fluid properties are calculated. These will act 
as input to the two- phase flow model. 

The Peng-Robinson equation is expressible in terms of the critical properties and the acentric 
factor. The equation is applicable to calculations of fluid properties in natural gas processes and 
is expected to provide good accuracy for the scenarios intended for the release model. The 
following chapters give a brief overview of the equation. For more details see Peng 1976. 
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1.2 Equations 
The following equations describe the Peng-Robinson Equation of State: 

R T a  
p   

2 2
V  b V  2bV  b
m m m 

0.45724R2TC 
2 

a  
Pc 

0.07780RT Cb  
Pc 

2 0.5   1 0.37464 1.54226  0.26992  1 Tr   2 

T
Tr  

TC 

where, 

Vm - molar volume, V / n 
ω - acentric factor 
R - universal gas constant, 8.314472 J/(K mol) 
Tc - critical temperature 
Pc - critical pressure 

An alternative form in terms of the compressibility factor Z replacing the molar volume from the 
real gas law is: 

3 2 2 2 2 3Z  1 B  2B Z  A  B  2B  2B  Z  A  B  B  B  0 

where, 

a  p

A  

2 2
R T
 
b  p


B  
R T 

This equation is used both for the gas phase and for the liquid phase. 

3 2 2 2 2 3Z  1 B  2B  Z  A  B  2B  2B  Z  A  B  B  B  0L L L L L LL L L L L L L 

3 2 2 2 2 3ZG  1 BG  2BG  ZG  AG  BG  2BG  2BG  ZG  AG  BG  BG  BG  0 
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1.3 Critical values and acentric factors 
Table A.1 shows the critical values and factors used by the equation of state. 

Table A.1: Critical values, acentric factors and compressibility factor 

Critical 
temp 

Critical 
pressure 

Accen 
fac 

Compr 
fac 

Critical 
vol 

Mol 
weight 

Symbol Name K bar - - cm/mol g/mol 
H hydrogen 33.2 12.8 -0.220 0.276 129.0 2.016 
CO2 carbon diox. 304.2 72.8 0.225 0.274 94.0 44.010 
N2 nitrogen 126-2 33.5 0.035 0.290 89.5 28.073 
C1 methane 190.6 45.2 0.013 0.288 99.0 16.043 
H2S hydr. sulfide 373.2 88.2 0.100 0.284 98.5 34.080 
C2 ethane 305-4 48.2 0.098 0.285 148.0 30.070 
C3 propane 369.8 41.9 0.152 0.281 203.0 44.097 
n-C4 n-buthane 425.2 37.5 0.193 0.274 255.0 58.124 
i-C4 i-buthane 408.1 36.0 0.176 0.283 263.0 58.124 
n-C5 n-penthane 469.6 33.3 0.251 0.262 304.0 72.151 
C6 hexane 507.4 29-3 0.296 0.260 370.0 86.178 
C7 heptane 540.2 27.0 0.351 0.263 432.0 100.205 
C8 octane 568.8 24.5 0.394 0.259 492.0 114.232 
C9 nonane 594.6 22.8 0.444 0.260 548.0 128.259 
C10 decane 619.2 20.8 0.490 0.247 603.0 142.286 

1.4 Solution algorithm 
The compressibility factors for liquid and gas phase, the equations are solved iteratively. The 
following is a step by step algorithm to calculate the equilibrium constants. 

1. The input data for the calculation are the pressure, temperature and fluid composition. 

2. Ki values for each component are guessed using the Wilson correlation (see below) 

3. On basis of the assumed Ki values, perform the flash calculations (see below) 

4.	 Compositions of liquid and gas phases obtained from flash calculations can be used to 
determine the fugacity y coefficients from each component 

5.	 Use the fugacity coefficient ratios to calculate the equilibrium constants Ki for each
 
component
 

6. Compare the guessed constants calculated in step 2 with the calculated values in step 5. 

7.	 If the convergence tolerance is satisfied for all components, the values of equilibrium 
constants are used to calculate the phase compositions required in determining phase 
physical properties. If not, the calculated values are used as the new guesses and steps 3 to 
6 are repeated until convergence is achieved. 
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The Wilson correlation is used to estimate the K values initially as in step 2 above. 

Pci 

 

 
Tci 




Ki  exp 5.37 1i  1  
p   T  

The flash calculations in step 3 above are performed using the following equation: 

zi Ki 1  G 
 

n 

y  xi    
n 

 f    0 
i 1 

i
i 1 Ki 1G 

1  F  
F 

Where, 

F - number of moles of composition 
L - number of moles of liquid 
G - number of moles of gas 
zi - mole fraction of component i in composition 
xi - mole fraction of component i in liquid phase 
yi - mole fraction of component i in gas phase 
n - total number of components in composition 

Once the compressibility factors of each phase are determined from the iterative procedure, all 
the required vapor and liquid properties can be determined. These include densities, viscosities, 
enthalpies, conductivities, heat capacities and surface tension. 

2 Dynamic Flow Simulation Model 

2.1 General 
This model is a transient two-phase flow model based on conservation equations. Two separate
 
mass and momentum equations for gas and liquid and one energy equation. Estimation of gas
 
release rates is based on flashing, integration, choking effects and fluid flow behavior in the
 
system. Total volume released is calculated from:
 

 Rate variation and release time,
 
 Leak detection time and production rates,
 
 Shutdown time for each component in the system,
 
 Location of rupture,
 
 Property changes with pressure and temperature,
 
 Frictional and hydrostatic pressure drop,
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2.2 Data requirements 
To provide the release results, the software needs the following information: 

 Geometrical description of the flow lines 
 Compositional input of the hydrocarbon fluid 
 Receiving pressure at the outlet of the system 
 Leak position and size 

2.3 Geometrical discretization 
Pipeline length and diameter must be specified. It might be of importance to specify dips and 
peaks along the pipeline where condensate could accumulate. Generally, finer grid results in 
more accurate calculations. Each user specified pipeline is discretized into a number of sections 
in the model and calculations are done for each of the section elements in the system. The 
computational time increases with the number of sections, and a short single pipeline is much 
faster to simulate than a complex network with many internal sections. 

2.4 Leak modeling 
The leak/rupture in a pipeline is modeled by implementation of a critical choke model with a 
diameter equal the equivalent diameter of the leak. The model handles both sub critical and 
critical flow. If the gas velocity in a choke exceeds the critical velocity, critical flow conditions 
are used. 
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2.5 Nomenclature for a pipeline layout 
The physical elements used to define a pipeline layout in the model are as follows: 

Pipe - an element with a given diameter, length, height, roughness and u value 
Branch - one or more connecting pipes in series (Figure A.1) 
Connection - connects two pipes 
Junction - connects two or more braches. 
Network - two or more connected branches (Figure A.2) 

Branch 1 

Figure A.1 Example sketch of a branch 

Figure A.2 Example sketch of a network 

A network can only have one outlet and one leak/rupture, but may have several inlets. 
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Appendix B: Gas Bubble Plume Algorithm Details 

1 Plume Modelling 

1.1 Sub sea gas bubble plume calculations 

The gas bubble plume calculations are based on the following input data: 

Discharge depth H0, m 
Gas mass flux q, kg/s 
Gas density  , kg/Sm3 (@ 1 atm and 15 oC) 

Sea temperature  s , 
oC 

Here, the gas mass flux is presumed to be delivered by the sub sea gas leak module in terms of a table 
of leak rates and corresponding times from the start of the leak. The gas mass flux is used together 
with discharge depth, sea temperature, and gas density to determine the volume flow rate V0 (m

3/s) at 
the discharge depth: 

V0  q / 0 (1) 

H 0 10 273 15
where 0   , assuming ideal gas 

10 273  s 

In the expression above, the number 10 corresponds to 10 m water column, which equals a 
hydrostatic pressure of one atmosphere. The volume flux at the discharge depth is used to define the 
buoyancy flux parameter 0  gV0 / 

The bubble plume calculations are based on Fanneløp’s general non-dimensional solution for 
underwater gas releases, shown in graphical form at Figure B.1 (Fanneløp and Sjøen 1980, Fanneløp 
1994). The critical assumption in the development of the solution is that the mass flux of gas is 
conserved, while the gas volume varies with hydrostatic pressure according to the ideal gas law. The 
expansion of the gas is assumed to be isothermal. Moreover, the initial momentum of the discharged 
gas is neglected, as well as possible effects of crossflow and stratification (due to vertical temperature 
and salinity gradients). This implies that the solution is valid for large gas leaks at moderate depths, 
but may be less reliable for small leak rates and large water depths due to enhanced influence of 
factors such as cross flow, stratification and dissolution of gas in the water masses (Johansen 2000). 

The plume is defined by three variables – plume radius bp, centerline velocity wp, and plume rise time 
tp – all functions of the vertical distance z from the discharge point. These variables may be expressed 
in terms of non-dimensional variables, X, B, W and T: 

X  z / H , B  b / 2 H , W  w / M and T  t M / H (2) p p p 

1/ 3
 2 1 

where H  H0 10 and M   2 0
2 H  
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Figure B.1 Fanneløp’s general gas bubble plume solution in non-dimensional form. Note that the 
non-dimensional rise time T is derived from the non-dimensional plume velocity W. 

The non-dimensional plume rise time T is derived from the non-dimensional plume velocity by the 
integral 

X 

T   dX /W (3) 
0 

The parameter  is the entrainment coefficient (  0.1), and  is a shape factor representing the 
ratio between the buoyancy and velocity profiles (  0.65) , both assumed constant with depth. 
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2 Surfacing of gas 
For the present purpose, the general solution presented in Chapter 1 may be curve fitted or 
interpolated from tabulated values and used to determine the plume variable bp, wp and tp on the basis 
of the input variables q, H0,  and  s . The plume variables are used to estimate the time dependent 

gas flow rates qa (kg/s) to the atmosphere and the corresponding radius RB (m) of the boiling zone. 

2.1 Surfacing rate 
The time of surfacing is determined from the time of discharge and the plume rise time corresponding 
to a given gas discharge rate. Thus, with gas flow rates q(i) tabulated at consecutive time steps (i = 1, 
2,..), the corresponding list of times of surfacing ts will represent the sum of the release time tr and the 
rise time tp: 

t (i)  t (i)  (1  ) t (i) (4) s r p 

where the factor  is introduced to account for the fact that the computed rise time tp is derived from 

the centerline plume velocity, while the rise time of a certain fraction of the gas flow will be longer 
due to the presumed Gaussian velocity distribution in the plume. Calculations based on a plume 
shape factor   0.65 show that the Gaussian velocity profile will causes a time lag in the surfacing 
gas flow rate of about 1/3 of the center line plume rise time, i.e.   0.333 (Figure B.2). 
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Figure B.2 Surfacing gas flow computed for a Gaussian plume velocity profile with shape factor 
  0.65.The red line shows the surface flow rate q (kg/s) relative to the gas flow rate qp 

in the plume, approximated with an exponential formula. The red markers show 
computed values for a plume with Gaussian velocity and density profiles and shape factor 
  0.65. The thick black line shows the cumulative gas flow Q, found by time integration 
of the red line. The thin black line is drawn for comparison and shows the cumulative gas 
flow without reduction, i.e. Qp  q pt (kg). 
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Figure B.2 is based on the assumption that the time development of the surface flow rate can be 
approximated by an exponential function of the form 

qt   q p 1 exp  t /  , (5) 

where  is the time constant. Computations made for a plume with Gaussian velocity and density 
profiles support this assumption, and indicates a time constant of about of 1/3 of the centerline plume 
rise time (see red markers on Figure B.2). Time integration of this exponential function gives the 
following expression for the cumulative surfacing gas flow: 

Qt  q p t  1 exp  t /  (6) 

For large times, t   , this equation can be approximated by Q  q p t   , which can be seen to 

imply a time lag  in the cumulative surface gas flow. 

The time dependent gas flow rate to the atmosphere is determined from the discharged mass of gas 
Q  q tr (kg) in the time interval tr  tr (i)  tr (i 1) , divided by the corresponding surfacing time 

period t  t (i)  t (i 1) :s s s 

q  Q / t  qt / t (7) a s r s 

A gas leak from a pipeline rupture will in general imply a sharp decrease in leak rate with time. Since 
the plume rise time tp will increase with decreasing gas discharge rates, this equation implies that the 
gas flow rate (kg/s) to the atmosphere will tend to be reduced relative to the gas discharge rate at the 
leak point. This also implies that the gas release to the atmosphere will last longer than the release 
period at the discharge point. 

2.2 Boiling zone 
The surface flow generated by a surfacing gas bubble plume has been investigated by Fanneløp and 
Sjøen (1980) and Milgram and Burgess (1984). Fanneløp and Sjøen derived a model for the zone 
where the flow is predominantly horizontal, while Milgram and Burgess focused on the turning 
region. In the present context, however, we need a continuous representation of the flow pattern. For 
this purpose, an algebraic solution has been derived that fulfils the continuity equation for volume 
flow, based on an assumed exponential reduction of the vertical velocity as the plume approaches the 
surface where the vertical velocity will be zero. 

The centerline velocity in the turning zone is thus specified as w(h)  wp 1 exp( h / h0 ), where h is 

the depth and h0 is a characteristic depth of the radial flow of entrained water. 

A Gaussian velocity profile is assumed in the undisturbed cross section of the plume with a centerline 
velocity wp and a characteristic radius bp. 

The algebraic model gives radial and vertical velocities u, w(r, h) at a certain radius r and depth h: 

wp bp 
2   r 2   h  

u(r, h)  0.5 1 exp 

 

2 
 exp   (8 a) 

r h0   bp   h0  
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 r 2    h  
w(r, h)  wp exp 


 

2 
 1 exp   (8 b) 

b h p    0  

The characteristic depth h0  a bp is related to the plume radius by a parameter a = 0.37 which has 

been tuned to match the initial conditions in the zone of radial flow derived by Fanneløp and Sjøen 
(1980). The corresponding flow field is visualized in terms of flow lines in Figure B.3, top frame. 

The radial distribution of the surfacing gas flux may be determined by computing trajectories of gas 
bubbles rising with a slip velocity wb in the flow field generated by the surfacing plume (see Figure 
B.3, bottom frame). 

Figure B.3 Flow field generated by a surfacing gas bubble plume. The top frame shows flow lines in 
the water, while the bottom frame shows flow lines for gas, presuming a bubble rise 
velocity of 0.3 m/s. 
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Here, the slip velocity for gas bubbles is assumed to be 0.3 m/s in correspondence with Fanneløp and 
Sjøen’s assumptions. Each flow line shown in the graph is enclosing a certain fraction of the gas flow 
in the undisturbed plume as indicated by the legend on the graph. For the present purpose, we have 
chosen to define the radius enclosing 90 % of the gas flow as the radius of the boiling zone, i.e. RB = 
R90. 

In order to facilitate the computation of the boiling zone, we have calculated the radius of the boiling 
zone for an arbitrary set of the plume parameters bp and wp. A curve fit of the results in non-
dimensional form is shown at Figure B.4. The thin line represents a best fit power law function based 
on the data points: 

0.68 R / b 1  0.29 w / w  (9) 90 p p b 

where wp and wb (m/s) are the plume velocity computed at the surface and the bubble slip velocity. 

Figure B.4 Normalized plot of the radius of the boiling zone R90 computed with the flow line 
approach described above. The plume parameters w and b are varied, while the slip 
velocity wb is kept constant (wb = 0.3 m/s). The thin line represents the best fit power law 
function (Eq. 9) 
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3 Transient leaks 
As all integral plume models, Fanneløp’s general solution for sub sea gas bubble plumes is based on 
the assumption of a stationary source. In the present context, this stationary solution is applied to 
instantaneous gas leak rates which vary with time. In general, such a quasi-stationary approach is 
presumed to be valid for slowly varying sources as long as the rise time is short relative to the time 
scale for the change in flow rate. However, in case of pipeline ruptures, strong transients may be 
expected at the start of the leak, with high initial leak rates tailing off with time as the internal 
pressure in the pipeline is reduced to the ambient hydrostatic pressure. 

One important issue in conjunction with transient leaks is the starting plume phenomenon – i.e. the 
gradual build up of a plume from a source which is turned on suddenly and then maintained at a 
constant rate. A theory for starting plumes which has been proposed by Bettelini and Fanneløp (1993) 
indicates that in the initial phase, the front of the plume will develop as a nearly spherical cap 
attached to a “normal” coned plume below. The cap will rise slower than the plume, and thus 
accumulate gas as it rises towards the surface. Thus, gas may be expected to be released into the 
atmosphere in a strong burst as the cap reaches the sea surface. However, with the rapidly 
diminishing leak rates which can be expected in case of a pipeline rupture, it is not obvious that a cap 
can be maintained: the diminishing leak rate at the source will cause the plume to slow down, and 
possibly lose speed relative to the cap. 

Neglecting the starting plume issue, we expect that the main effects of a diminishing leak rate will be 
(1) a reduction in the mass flow rate of gas through the sea surface relative to the mass flow rate at 
the source, and (2) an extension of the time period when gas is leaking into the atmosphere relative to 
the leak period at the source. These effects are demonstrated at Figure B.5 which show surfacing gas 
flow computed from a gas leak from an assumed pipeline rupture at 400 m depth. 

Figure B.5 Surface gas flow computed for a major sub sea gas pipe rupture at 400 m depth. The 
curves show the sub sea leak rate (black) and the corresponding surface flow rate (blue). 
The sub sea leak rate is sampled at 10 seconds intervals. 
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Figure B.6 Radius of boiling zone R90 computed for the same case as shown in Figure B.5. Thin line 
shows R90 computed by equation 9, while the thick line accounts for a gradual build up of 
the boiling zone (see text). 

Figure B.5 shows that in this case, the surfacing of gas will be delayed by about 3 minutes (170 
seconds) due to the rise time of the initial plume, and also reduced considerably in strength due to 
increasing rise times caused by a continuous reduction in the sub sea leak rates. For the same reason, 
the surface gas flow will also last for a considerably longer period than the sub sea leak. 

Figure B.6 shows the radius of the boiling zone for the same case. The thin line shows the boiling 
zone computed directly from the plume radius and rise velocity by equation 9, while the thick line 
includes a gradual growth of the area of the boiling zone with time corresponding to the build up of 

2 2the gas flow rate, i.e.  R t/ R90  q t/ qp , which implies 

R(t)  R90 1 exp  t / 1/ 2 
(10) 

where  is the time constant introduced in section 2. 
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4 Summary of model concept and formulas 

This chapter summarizes the model concepts and formulas to be used in the programming of the 
model of gas behaviour in the water column as a result of the previous discussion. Note that the 
equations listed in this chapter are numbered in brackets, to be distinguished from equation numbers 
used in the previous chapters. 

4.1 Sub sea gas bubble plume 

Input variables 

Discharge depth H0, m 
Gas mass flux q, kg/s 
Gas density  , kg/Sm3 (@ 1 atmosphere and 15 oC) 

Sea temperature  s , 
oC 

Volume flow rate V0 (m
3/s) at the discharge depth 

V0  q / 0 1 

H 0 10 273 15
where 0   , assuming ideal gas 

10 273  s 

The number 10 corresponds to 10 m water column, which equals a hydrostatic pressure of one 
atmosphere. The volume flux at the discharge depth is used to define the buoyancy flux parameter: 

0  gV0 / 2 

Fanneløp’s general bubble plume model 

Plume variables, all given as a function of the distance z (m) above the leak point: 

bp: plume radius, m 

wp: plume velocity, m/s 

tp: rise time, s 

Non-dimensional variables: 

X  z / H , B  b / 2 H , W  w / M and T  t M / H 3p p p 

1/ 32   1
where H  H0 10 and M   2 0

2 H  

The parameter  is the entrainment coefficient (  0.1), and  is a shape factor representing the 
ratio between the buoyancy and velocity profiles (  0.65) , both assumed constant with depth. 

Values of B, W and T are given in Table B.2 as a function of the non-dimensional depth X. 
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Table B.2 Fanneløp’s general bubble plume solution for isothermal expansion. Dimensionless 
plume variable B, W and T as a function of dimensionless height X. 

X B W T 
0.02 0.012 4.73 0.004 
0.08 0.048 3.03 0.020 
0.14 0.083 2.56 0.042 
0.20 0.118 2.32 0.067 
0.26 0.152 2.18 0.093 
0.32 0.186 2.08 0.122 
0.38 0.22 2.01 0.151 
0.44 0.252 1.97 0.181 
0.50 0.284 1.94 0.212 
0.56 0.314 1.93 0.243 
0.62 0.344 1.94 0.274 
0.68 0.372 1.97 0.304 
0.74 0.397 2.01 0.335 
0.80 0.42 2.09 0.364 
0.86 0.438 2.21 0.392 
0.92 0.447 2.43 0.418 
0.98 0.427 3.04 0.440 

4.2 Surfacing of gas 

Input variables 

Time series of leak rates q = f(tr), where tr is release time. The leak rate values q(i) should preferably 
be tabulated at fixed time increments t(i) = i × t . 

Surfacing time 

Compute surfacing times from release time tr and plume rise time tp: 

t (i)  t (i)  (1  ) t (i) 4s r p 

where the shape factor   0.333 

Surfacing rate 

Compute surfacing rates from 

q  Q / t  qt / ta s r s 5 

where tr  tr (i)  tr (i 1) and ts  ts (i)  ts (i 1) 

Boiling zone 

Compute radius of boiling zone (R90) from: 

0.68 R / b  1 0.29 w / w  690 p p b 

where wp and wb (m/s) are the plume velocity computed at the surface and the bubble slip velocity 
(0.3 m/s). 
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For transient leaks, the gradual increase in the radius if the boiling zone may accounted for by use of 
the following equation: 

R(t)  R90 1 exp  t / 1/ 2 
7 

where the time constant   t p / 3 and t is the cumulative surfacing time (time of surfacing counted 

from start of leak). 

4.3 Computational procedures 

Procedure to be applied for each subsequent leak rate in the time series Eq. 

1 Compute volume flow rate V0 at discharge depth from gas mass flux q, gas 
density  and water depth H0, corrected for sea temperature s . 

1 

2 Compute buoyancy flux parameter 0 from V0. 2 

3 Determine non-dimensional plume variables B, W and T at sea surface, X=H0/H 
by interpolation in the general solution. 

Table 
B.2 

4 Compute plume variables bp, wp and tp at sea surface from B, W and T via the 
scaling variables H and M. 

3 

5 Compute surfacing time ts from release time tr and plume rise time tp  

6 Compute surfacing rate qa from leak rate q and incremental release and surfacing 
times 

 

7 Compute radius of boiling zone R90 from plume radius bp and plume rise velocity 
wp, corrected for transients with time constant  derived from plume rise time tp 

 

5 Testing and validation of the gas bubble plume model 

The bubble plume model chosen for this project is based on the work of Fanneløp and Sjøen, 
published in 1980 (Fanneløp and Sjøen, 1980). The authors developed the governing equations for a 
bubble plume in stagnant and homogeneous water, and solved them in a non dimensional form. The 
results were presented as tables of the non dimensional plume rise velocity and diameter, W and B as 
a function of the non dimensional plume height X. The non dimensional plume variables where 
defined as 

X  z / H , B  b / 2H , W  w / M , 

0 (1 
2 )

1/ 3 

where M   2  , H  D  H 0 and 0  gV0 / . 
2 H  

Here, D is the discharge depth and V0 is the volume flow of gas at the discharge point. 

The solution contains two empirical constant, the entrainment coefficient  and the profile 
parameter  , the latter defining the ratio between the length scale of the buoyancy profile and the 
velocity profile. These parameters were determined from gas plume experiments conducted by 
Fanneløp and Sjøen in a 5 meter deep basin. The experiments indicated that the entrainment 
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coefficient was depending on the gas flow rate. By including experimental results from other sources, 
they concluded that for small gas flow rates, the values were in the range  0.07 - 0-08, and for 
larger flow rates the value approaches   0.1or larger (> 10 L/s at standard conditions). The profile 
parameter was estimated to  = 0.65. The values for large gas flow rates have been confirmed by 
recent research, but smaller values have been found for the entrainment coefficient in small scale 
tests (Seol et al. 2007). 

Fanneløp’s general solution for subsea bubble plumes was developed for homogeneous water with no 
cross flow. For such conditions, the model has been verified against experiments. However, 
Socolofsky and Adams (2002) identified two factors that could change the plume behaviour in 
stratified waters with crossflow; the first is the possible separation of bubbles from an inclined plume, 
and the second is the possible trapping of the plume due to a stable stratification (the plume reaches a 
level of neutral buoyancy). They proposed expressions for the separation height hS and the trapping 
height hT based on experimental studies: 

0.88 1/ 42.4 3h  5.1F /u u and h  2.8 F / N S B S T B 

Here, u is the strength of the cross flow and uS is the rise velocity of gas bubbles,
 

F  V g(   ) /  is the buoyancy flux, and N   g /  / z1/ 2 
is the Brunt-Vaisälä
 B 0 G 

buoyancy frequency. The density of sea water,  is in general much larger than the density of the 

gas G . 

These equations may be used as a check of the possible influence of cross flow and stratification: If 
the smallest of the resulting heights are larger than the release depth, the plume is likely to be under 
no influence of the crossflow or stratification. However, since both the strength of the cross flow and 
the stratification will vary with depth in real cases, practical application of this criterion is not 
obvious. As a demonstration, we have used Socolofsky’s equation for the separation height to 
estimate the lower limit of the gas flow rate as a function of discharge depth (Figure B.7). The curves 
for 25 and 50 cm/s current speed show the gas flow rate that will give a separation height equal to the 
discharge depth. Smaller rates may cause separation of gas bubbles during plume rise, causing a 
change in the plume behaviour (eventually complete loss of buoyancy). 
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Figure B.7 Limiting gas flow rate as a function of discharge depth. The values are computed by use 
of Socolofsky’s separation height formula. 

The results in Figure B.7 show that with gas leak rates larger than 10 kg/s, the bubble plume can be 
expected to rise to the surface even from 500 m depth without separation of gas bubbles in cross 
flows up to 50 cm/s. It should be noted that in pipeline ruptures, gas leak rates can be one or more 
magnitudes above this limit. Moreover, due to gas expansion, the buoyancy flux generated by a 
pipeline rupture at the sea bed will increase as the plume approaches the surface. The present 
calculations, based on the buoyancy flux at the discharge level are thus on the conservative side. 

A similar presentation might be made for the trapping height, but the equation for the trapping height 
presumes a constant density gradient. In reality, mainly the surface layers in the ocean tend to show 
any clear stratification (50 meter and shallower), while sea temperature and salinity gradients 
normally will be small (and negligible) near the sea bed. This, and the strong gain in buoyancy flux 
due to gas expansion as the plume rises to the surface, makes it very unlikely that a gas bubble plume 
from a major sub sea pipeline rupture will be trapped before it reaches the sea surface. 
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Appendix C: Summary of OCD/5 Source Code 
Modifications 

1 Source Code and Compiler 

The fortran source code provided with the OCD/5 download from the following 
US EPA web site (http://www.epa.gov/scram001/dispersion_prefrec.htm) was used as a 
starting point for the code modifications. 

The G95 Fortran compiler available from http://www.g95.org was used to recompile the 
fortran code for the main simulation module OCD.for. 

The following compile options were used to successfully compile the code: 

G95 –freal-loops -fsloppy-char -ftrace=full ocd.for 

2 Code Modifications 

The modified OCD.for code has been delivered on CD with the final digital report copies. 
Modifications to the code have been identified by inserting “SL Ross” in the fortran code 
comments prior to the code modifications. 

The primary changes made to the code include: 

1.	 Removal of the requirement that the emissions.dat date stamp match that of the 
LMET and WMET meteorological datasets. The software as delivered now 
requires that the number of hourly emissions lines present in the emissions.dat 
file is at least as large as the Length of the Run (number of averaging periods) 
entered in the Run Information Dialog of OCD/5. (Lines 2250 to 2256 and 2748 
to 2753 commented out in OCD.for) 

2.	 Modification of the software so the Starting Day and Hour of the run no longer 
have to be hour 1. This was an apparent ‘bug’ in the original software. Any 
starting day and hour can be selected in the current compile so long as the length 
of the run does not extend past the end of a given day. In other words, if a 
simulation has a 4-hour run length then the starting hour must be less than 20. 
(Lines 507& 508 in OCD.for) 

3.	 Modified the code so the output concentration is in mg/m3 rather than μg/m3 and 
output is generated only until concentrations reach 1 mg/m3. This was 
implemented because natural gas concentrations below 35000 mg/m3 (Lower 
Explosive Limit for natural gas) are not hazardous and there is no need to track 
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extremely low concentrations in this application. (Lines 1774, 1775 & 1789 in 
OCD.for) 

4.	 Modified the code so the year data in the LMET.dat file can be entered in either 
2-digit or Y2K compliant format. The LMET files generated using PCRAMMET 
and those pre-developed for the Gulf of Mexico Region can be used without 
modification with this change (Lines 5598 to 5611 in OCD.for) 

5.	 Addition of a system call to GNUPLOT to plot the simulation results at the end 
of an OCD/5 modeling Run. Added subroutine ‘rungnuplot’ and a call to the 
subroutine to plot the data present in the secondary output summary file 
(‘extra.out’) generated by OCD/5. (Lines 9313 to 9363 lines 582 to 584 in 
OCD.for) 

The instance of GNUPLOT called within OCD/5 uses the ‘emiss.gpl’ script file 
reproduced below to generate the plot. Modifications to the plot can be made by 
modifying this script. The script can also be called using the ‘replot filename’ command 
to plot any simulation results that have been previously run and archived. 

‘emiss.gpl” script file 
set autoscale 
unset log 
unset label 
set style line 1 linetype rgb "red" lw 2 
set style line 2 linetype rgb "yellow" lw 1 
set style line 3 linetype rgb "blue" lw 2 
set style line 4 linetype rgb "violet" lw 2 
set style line 5 linetype rgb "cyan" lw 2 
set xtic 0.5 
set ytic auto 
set ztic auto 
set xzeroaxis linetype 3 linewidth 2.5 
set yzeroaxis linetype 4 linewidth 2.5 
set zzeroaxis linetype 5 linewidth 2.5 
set title "Left Click on Graph - Hold Click and Drag Mouse to Change Graph 

View" 
set xlabel "Down Wind Distance X(km)" 
set ylabel "Cross Wind Distance Y(km)" 
set zlabel "Gas Conc. (mg/m3)" 
set view 80,17,1,1 
splot "extra.out" using 5:6:23 with lines 2,"nglel.dat" using 1:2:3 w l 1 
set label 1 'Lower Explosive Limit for Natural Gas' at 2,0,40000 tc rgb "red" 
set label 2 'Sea Level Gas Concentrations' at 0,0,-5000 tc rgb "green" 
pause -1 
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Appendix D: Guide for Preparation of LMET and WMET 
Data Files for OCD/5 

LMET and WMET data files are available for the Gulf of Mexico Region (Douglas, 
2008) for five years (2000 to 2004). Sample files for use in this project were acquired 
from the MMS contact provided below. 

Holli Ensz, Physical Scientist 
Minerals Management Service 
Office of Leasing and Environment 
1201 Elmwood Park Blvd. 
New Orleans, LA 70123 
504-736-2536 

Data files for other regions can be developed using the procedures identified below. 

1 Overland Meteorology Files – LMET 
The overland meteorology (LMET) data sets required by OCD/5 are generated from two 
data sources using the PCRAMMET.exe program. Hourly overland wind and twice daily 
mixing height data files are used by the program. These files are available through the 
EPA’s SCRAM database located at http://www.epa.gov/scram001/surfacemetdata.htm. 

Data files containing the mixing height data available from EPA’s archive have been 
included with the deliverables for this project. The names of these files are: 

 Camix.zip (California) 
 Akmix.zip (Alaska) 
 Ormix.zip (Oregon) 
 Txmix.zip (Texas) 
 Wamix.zip (Washington) 

These files contain yearly data sets of mixing height data, for one or more locations 
within the region, for the years from 1984 to 1992. 

Only one mixing height station is available for California. The station number is 23230 
with a latitude of 37.75, longitude of 122.2 and a time zone designation of 8. A full list of 
the mixing height stations in the United States is provided in Table D1. 

Data files containing the hourly overland wind data available from EPA’s archive for the 
state of California have been included with the deliverables for this project. The names of 
these files are: 

 Ca23161.zip 
 Ca23174.zip 
 Ca23188.zip 
 Ca23190.zip 
 Ca23232.zip 

76
 

http://www.epa.gov/scram001/surfacemetdata.htm


 Ca24216.zip
 
 Ca24257.zip
 
 Ca24283.zip
 
 Ca93193.zip
 

A complete list of the over-land surface meteorological stations in the United States is 
available on the EPA web site and is reproduced here as Table D2. The positions of the 
California sites can be found in Table D2. The most logical choice for most pipeline 
release modeling in California will be station 23174. 

The 1991 data for station 23174 (Los Angeles International Airport) with latitude of 
33.933, longitude of 118.383 and a time zone designation of 8 has been used in the 
example data sets generated for this project. 

The PCRAMMET.exe program is executed from a Command Prompt window to 
generate the final LMET data file used by OCD/5. When the program is run it prompts 
the user for various input information. Respond with the following inputs: 

 Wet or Dry deposition calculations? - None 
 Output filename? - LMET????.DAT (user specified output name) 
 Output File type? - ASCII 
 Mixing Height Data File Name? – 23230-89.txt (for California region in 1989 

from camix.zip) 
 Hourly Surface Data File Name? – 23174-89.DAT (1989 hourly wind data) 
 Surface data format? – SCRAM 
 Latitude? – 33.933 (data for station 23174) 
 Longitude? – 118.383 (data for station 23174) 
 Time zone? – 8 (data for station 23174) 

The program generates a data file compatible with the OCD/5 dispersion model. 

2 Over-water Meteorology Files – WMET 
The over-water meteorology (WMET) data sets required by OCD/5 are generated from 
data collected at offshore buoys. These files are available through NOAA’s National Data 
Buoy Center database located at http://www.ndbc.noaa.gov/. Historical data can be 
downloaded from this site for specific offshore buoys located in the region of interest. 
The web site presents a worldwide map of available offshore buoys. The user zooms into 
the region of interest and selects a buoy to see the general description of the buoy. Details 
regarding the buoy’s temperature and wind sensor heights that are required by OCD/5 
can be obtained by accessing the ‘View Details’ option provided in the pop-up for the 
buoy. Selecting the ‘View History’ option accesses the actual buoy data. This presents 
the user with a number of data options. The option appropriate for the WMET file 
creation is ‘Historical data – Standard meteorological data’. The user selects the year of 
historical data of interest and the data can be downloaded directly as a text file and then 
saved by the user. It is best to rename the data file to one with a maximum eight-character 
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--------- ------------ ----- --- --- ----

filename and 3-character extension (txt) as the OCD/5 data input can only handle 
filenames with the old DOS naming limitations. This text file requires additional 
modification prior to use in OCD/5. A program called Buoymet.exe has been developed 
as part of this project to add over-water mixing zone height information to the data set 
and to convert temperature data to Kelvin units (as required by OCD/5). The program is 
executed in a Command Prompt window by typing “Buoymet infilename outfilename 
500” at the system command prompt. The buoymet.exe file and the buoy data text file 
(infilename) must be in the same directory or folder for this program to function. The 
infilename is the name of the offshore buoy text data file downloaded from NOAA’s web 
site (renamed to DOS file name convention). The outfilename (again use DOS filename 
convention) is the WMET file name to be used in OCD/5. The ‘500’ is a default mixing 
zone height, in meters, used for over-water dispersion modeling. 

Table D1 SCRAM MIXING HEIGHT STATIONS 

Station # Station Name State Lat Lon Zone 

26409 ANCHORAGE AK 61.217 149.833 9
 
26617 NOME/MUNICIPAL ARPT AK 64.500 165.433 9
 
26411 FAIRBANKS/INT'L ARPT AK 64.817 147.867 9
 
27502 BARROW/W POST-W ROGERS ARPT AK 71.300 156.783 9
 

03952 NORTH LITTLE ROCK AR 34.833 92.250 6
 
13963 LITTLE ROCK/ADAMS FIELD AR 34.733 92.233 6
 

23160 TUCSON/INT'L ARPT AZ 32.133 110.933 7 

23230 OAKLAND/WSO AP CA 37.750 122.200 8 

23066 GRAND JUNCTION/WALKER FIELD CO 39.117 108.533 7
 
23062 DENVER/STAPLETON INT'L ARPT CO 39.767 104.867 7
 

12844 WEST PALM BEACH/INT'L ARPT FL 26.683 80.117 5
 
12842 TAMPA/INT'L ARPT FL 27.967 82.533 5
 
12832 APALACHICOLA/MUNICIPAL ARPT FL 29.733 85.033 5
 

13861 WAYCROSS/WSMO GA 31.250 82.400 5
 
13873 ATHENS/MUNICIPAL ARPT GA 33.950 83.317 5
 

21504 HILO/GENERAL LYMAN FIELD HI 19.717 155.067 10
 
22536 LIHUE/ARPT HI 21.983 159.350 10
 

24131 BOISE/AIR TERMINAL ID 43.567 116.217 7 

03879 SALEM IL 38.633 88.950 6
 
14842 PEORIA/GREATER PEORIA ARPT IL 40.667 89.683 6
 

13985 DODGE CITY/MUNICIPAL ARPT KS 37.767 99.967 6
 
13996 TOPEKA/MUNICIPAL ARPT KS 39.067 95.633 6
 

03816 PADUCAH/WSO AIRPORT KY 37.067 88.767 6 

12884 BOOTHVILLE/WSCMO CITY LA 29.333 89.400 6
 
03937 LAKE CHARLES/MUNICIPAL ARPT LA 30.117 93.217 6
 
53813 Slidell LA 30.333 89.820 6
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5 14684 CHATHAM/WSMO MA 41.667 69.950 

14764 PORTLAND/INT'L JETPORT ME 43.650 70.317 5 
14607 CARIBOU/MUNICIPAL ARPT ME 46.867 68.017 5 

14826 FLINT/BISHOP ARPT MI 42.967 83.750 5 
14847 SAULT STE MARIE/NWSO MI 46.467 84.350 5 

14926 ST CLOUD/MUNICIPAL ARPT MN 45.550 94.067 6 
14918 International Falls/INT'L ARP MN 48.567 93.383 6 

03946 MONETT/WSMO MO 36.883 93.900 6 

03940 JACKSON/THOMPSON FIELD MS 32.317 90.083 6 

24143 GREAT FALLS/INT'L ARPT MT 47.483 111.367 7 
94008 GLASGOW/INT'L ARPT MT 48.217 106.617 7 

93729 CAPE HATTERAS/WSO NC 35.267 75.550 5 
13723 GREENSBORO,HIGH POINT /WINSTO NC 36.083 79.950 5 

24011 BISMARCK/MUNICIPAL ARPT ND 46.767 100.750 6 

24023 NORTH PLATTE/LEE BIRD FLD NE 41.133 100.683 6 
94918 NORTH OMAHA/NWSFO ARPT NE 41.367 96.017 6 

93755 ATLANTIC CITY NJ 39.750 74.667 5 

23050 ALBUQUERQUE/INT'L ARPT NM 35.050 106.617 7 

03160 DESERT ROCK NV 36.617 116.017 8 
24128 WINNEMUCCA/WSO AIRPORT NV 40.900 117.800 8 

14735 ALBANY/COUNTY ARPT NY 42.750 73.800 5 
14733 BUFFALO/GREATER BUFFALO INT'L NY 42.933 78.733 5 

13840 WRIGHT PATTERSON/AFB OH 39.817 84.050 5 

03948 NORMAN OK 35.233 97.467 6 
13967 OKLAHOMA CITY/WILL ROGERS WOR OK 35.400 97.600 6 

24225 MEDFORD/JACKSON COUNTY ARPT OR 42.383 122.883 8 
24232 SALEM/MCNARY FIELD OR 44.917 123.000 8 

94823 PITTSBURGH/WSCOM 2 AIRPORT PA 40.500 80.217 5 

11641 SAN JUAN/ISLA VERDE INT'L ARP PR 18.433 66.000 4 

13880 CHARLESTON/INT'L ARPT SC 32.900 80.033 5 

14936 HURON/REGIONAL ARPT SD 44.383 98.217 6 
24090 Rapid City SD 44.050 103.066 6 

13897 NASHVILLE/METRO ARPT TN 36.117 86.683 6 

12919 BROWNSVILLE/INT'L ARPT TX 25.900 97.433 6 
12924 CORPUS CHRISTI/INT'L ARPT TX 27.767 97.500 6 
12912 VICTORIA/WSO AIRPORT TX 28.850 96.917 6 
22010 DEL RIO/INT'L ARPT TX 29.367 100.917 6 
23044 EL PASO/INT'L ARPT TX 31.800 106.400 7 
23023 MIDLAND/REGIONAL AIR TERMINAL TX 31.950 102.183 6 
13901 STEPHENVILLE/WSMO TX 32.217 98.183 6 
03951 LONGVIEW/WSMO TX 32.350 94.650 6 
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23047 AMARILLO/INT'L ARPT TX 35.233 101.700 6 

24127 SALT LAKE CITY/INT'L ARPT UT 40.783 111.950 7 

93739 WALLOPS ISLAND VA 37.850 75.483 5 
93734 STERLING VA 38.983 77.467 5 

24157 SPOKANE/INT'L ARPT WA 47.633 117.533 8 
94240 QUILLAYUTE/WSO AIRPORT WA 47.950 124.550 8 

14898 GREEN BAY/AUSTIN STRAUBEL FIE WI 44.483 88.133 6 
03860 HUNTINGTON/TRI-STATE ARPT WV 38.367 82.550 5 

24021 LANDER/HUNT FIELD WY 42.817 108.733 7 
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--------- ------------ ----- --- --- ----

Table D2 SCRAM SURFACE DATA STATIONS 

Station # Station Name State Lat Lon Zone 

25624 COLD BAY/ARPT AK 55.200 162.717 9 
25501 KODIAK/U S C G BASE AK 57.750 152.500 9 
25309 JUNEAU/INT'L ARPT AK 58.367 134.583 9 
25503 KING SALMON/ARPT AK 58.683 156.650 9 
25339 YAKUTAT/STATE ARPT AK 59.517 139.667 9 
25507 HOMER/ARPT AK 59.633 151.500 9 
26615 BETHEL/WSO AIRPORT AK 60.783 161.800 9 
26442 VALDEZ/WSO AK 61.133 146.350 9 
26451 ANCHORAGE/WSMO AIRPORT AK 61.167 150.017 9 
26409 ANCHORAGE AK 61.217 149.833 9 
26510 MC GRATH/ARPT AK 62.967 155.617 9 
26617 NOME/MUNICIPAL ARPT AK 64.500 165.433 9 
26411 FAIRBANKS/INT'L ARPT AK 64.817 147.867 9 
26616 KOTZEBUE/RALPH WEIN MEMORIAL AK 66.867 162.633 9 
26533 BETTLES/BETTLES FIELD AK 66.917 151.517 9 
27401 BARTER ISLAND/WSO AIRPORT AK 70.133 143.633 9 
27502 BARROW/W POST-W ROGERS ARPT AK 71.300 156.783 9 

13894 MOBILE/WSO AIRPORT AL 30.683 88.250 6 
13895 MONTGOMERY/WSO ARPT AL 32.300 86.400 6 
03881 CENTERVILLE/WSMO AL 32.900 87.250 6 
13876 BIRMINGHAM/MUNICIPAL ARPT AL 33.567 86.750 6 
03856 HUNTSVILLE/MADISON COUNTY JET AL 34.650 86.767 6 

13963 LITTLE ROCK/ADAMS FIELD AR 34.733 92.233 6 
13964 FORT SMITH/MUNICIPAL ARPT AR 35.333 94.367 6 

23160 TUCSON/INT'L ARPT AZ 32.133 110.933 7 
23183 PHOENIX/SKY HARBOR INT'L ARPT AZ 33.433 112.017 7 
23184 PRESCOTT/MUNICIPAL AZ 34.650 112.433 7 

23188 SAN DIEGO/LINDBERGH FIELD CA 32.733 117.167 8 
23174 LOS ANGELES/INT'L ARPT CA 33.933 118.383 8 
23190 SANTA BARBARA/FAA AIRPORT CA 34.433 119.833 8 
23161 DAGGETT/FAA AIRPORT CA 34.867 116.783 8 
93193 FRESNO/AIR TERMINAL CA 36.767 119.717 8 
23234 SAN FRANCISCO/INT'L ARPT CA 37.617 122.383 8 
23232 SACRAMENTO/EXECUTIVE ARPT CA 38.517 121.500 8 
24216 RED BLUFF/MUNICIPAL ARPT CA 40.150 122.250 8 
24257 REDDING/AAF CA 40.500 122.300 8 
24283 ARCATA/ARPT CA 40.983 124.100 8 

93037 COLORADO SPRINGS/MUNICIPAL AR CO 38.817 104.717 7 
23066 GRAND JUNCTION/WALKER FIELD CO 39.117 108.533 7 
23062 DENVER/STAPLETON INT'L ARPT CO 39.767 104.867 7 
93010 Limon CO 39.266 103.700 7 

14740 HARTFORD/BRADLEY INT'L ARPT CT 41.933 72.683 5 

13781 WILMINGTON/GREATER WILMINGTON DE 39.667 75.600 5 

12836 KEY WEST/INT'L ARPT FL 24.550 81.750 5 
12839 MIAMI/INT'L ARPT FL 25.800 80.300 5 
12835 FORT MYERS/PAGE FIELD FL 26.583 81.867 5 
12844 WEST PALM BEACH/INT'L ARPT FL 26.683 80.117 5 
12843 VERO BEACH/MUNICIPAL AIRPORT FL 27.650 80.417 5 
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12842 TAMPA/INT'L ARPT FL 27.967 82.533 5 
12815 ORLANDO/INT'L ARPT FL 28.450 81.317 5 
12834 DAYTONA BEACH/REGIONAL ARPT FL 29.183 81.050 5 
12816 GAINESVILLE/MUNICIPAL AIRPORT FL 29.683 82.267 5 
12832 APALACHICOLA/MUNICIPAL ARPT FL 29.733 85.033 5 
93805 TALLAHASSEE/MUNICIPAL ARPT FL 30.383 84.367 5 
13899 PENSACOLA/REGIONAL ARPT FL 30.467 87.200 6 
13889 JACKSONVILLE/INT'L ARPT FL 30.500 81.700 5 

13861 WAYCROSS/WSMO GA 31.250 82.400 5 
03822 SAVANNAH/MUNICIPAL ARPT GA 32.133 81.200 5 
93842 COLUMBUS/METROPOLITAN ARPT GA 32.517 84.950 5 
03813 MACON/LEWIS B WILSON ARPT GA 32.700 83.650 5 
03820 AUGUSTA/BUSH FIELD GA 33.367 81.967 5 
13874 ATLANTA/ATLNA-HARTSFIELD INT' GA 33.650 84.433 5 
13873 ATHENS/MUNICIPAL ARPT GA 33.950 83.317 5 

21504 HILO/GENERAL LYMAN FIELD HI 19.717 155.067 10 
22521 HONOLULU/INT'L ARPT HI 21.333 157.917 10 
22536 LIHUE/ARPT HI 21.983 159.350 10 

14933 DES MOINES/INT'L ARPT IA 41.533 93.650 6 
14943 SIOUX CITY/MUNICIPAL ARPT IA 42.400 96.383 6 
94910 WATERLOO/MUNICIPAL ARPT IA 42.550 92.400 6 
14940 MASON CITY/FAA AIRPORT IA 43.150 93.333 6 

24156 POCATELLO/MUNICIPAL ARPT ID 42.917 112.600 7 
24131 BOISE/AIR TERMINAL ID 43.567 116.217 7 

93822 SPRINGFIELD/CAPITAL ARPT IL 39.850 89.683 6 
14842 PEORIA/GREATER PEORIA ARPT IL 40.667 89.683 6 
14923 MOLINE/QUAD-CITY ARPT IL 41.450 90.500 6 
94846 CHICAGO/O'HARE INT'L ARPT IL 41.983 87.900 6 
94822 ROCKFORD/GREATER ROCKFORD ARP IL 42.200 89.100 6 

93817 EVANSVILLE/DRESS REGIONAL ARP IN 38.050 87.533 6 
93819 INDIANAPOLIS/INT'L ARPT IN 39.733 86.267 5 
14827 FORT WAYNE/BAER FIELD IN 41.000 85.200 5 
14848 SOUTH BEND/MICHIANA REGIONAL IN 41.700 86.317 5 

03928 WICHITA/MID-CONTINENT ARPT KS 37.650 97.433 6 
13985 DODGE CITY/MUNICIPAL ARPT KS 37.767 99.967 6 
93997 RUSSELL/FAA AIRPORT KS 38.867 98.817 6 
13996 TOPEKA/MUNICIPAL ARPT KS 39.067 95.633 6 
23065 GOODLAND/RENNER FIELD KS 39.367 101.700 7 
13984 CONCORDIA/BLOSSER MUNICIPAL A KS 39.550 97.650 6 

03816 PADUCAH/WSO AIRPORT KY 37.067 88.767 6 
03889 JACKSON/JULIAN CARROLL ARPT KY 37.600 83.317 5 
93820 LEXINGTON/BLUEGRASS FIELD KY 38.033 84.600 5 
93821 LOUISVILLE/STANDIFORD FIELD KY 38.183 85.733 5 
93814 COVINGTON/GREATER CINCINNATI KY 39.050 84.667 5 

12916 NEW ORLEANS/INT'L ARPT LA 29.983 90.250 6 
03937 LAKE CHARLES/MUNICIPAL ARPT LA 30.117 93.217 6 
13970 BATON ROUGE/RYAN ARPT LA 30.533 91.133 6 
13957 SHREVEPORT/REGIONAL ARPT LA 32.467 93.817 6 

14739 BOSTON/LOGAN INT'L ARPT MA 42.367 71.033 5 

93721 BALTIMORE/BLT-WASHNGTN INT'L MD 39.183 76.667 5 
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14764 PORTLAND/INT'L JETPORT ME 43.650 70.317 5 
14606 BANGOR/FAA AIRPORT ME 44.800 68.817 5 

94847 DETROIT/METROPOLITAN ARPT MI 42.233 83.333 5 
14822 DETROIT/CITY AIRPORT MI 42.417 83.017 5 
14836 LANSING/CAPITAL CITY ARPT MI 42.767 84.600 5 
94860 GRAND RAPIDS/KENT CO INT'L AR MI 42.883 85.517 5 
14826 FLINT/BISHOP ARPT MI 42.967 83.750 5 
14840 MUSKEGON/COUNTY ARPT MI 43.167 86.233 5 
14850 TRAVERSE CITY/FAA AIRPORT MI 44.733 85.583 5 
94849 ALPENA/PHELPS COLLINS AP MI 45.067 83.567 5 
14847 SAULT STE MARIE/NWSO MI 46.467 84.350 5 

14925 ROCHESTER/MUNICIPAL ARPT MN 43.917 92.500 6 
14922 MINNEAPOLIS-ST PAUL/INT'L ARP MN 44.883 93.217 6 
14913 DULUTH/INT'L ARPT MN 46.833 92.183 6 
14918 INTERNATIONAL FALLS/INT'L ARP MN 48.567 93.383 6 

13995 SPRINGFIELD/REGIONAL ARPT MO 37.233 93.383 6 
03966 ST LOUIS/SPIRIT OF ST LOUIS MO 38.650 90.633 6 
13994 ST LOUIS/LAMBERT INT'L ARPT MO 38.750 90.367 6 
03945 COLUMBIA/REGIONAL ARPT MO 38.817 92.217 6 
13988 KANSAS CITY/FAA AIRPORT MO 39.117 94.600 6 
03947 KANSAS CITY/INT'L ARPT MO 39.317 94.717 6 

03940 JACKSON/THOMPSON FIELD MS 32.317 90.083 6 
13865 MERIDIAN/KEY FIELD MS 32.333 88.750 6 
93862 TUPELO MS 34.250 88.717 6 

24033 BILLINGS/LOGAN INT'L ARPT MT 45.800 108.533 7 
24037 MILES CITY/MUNICIPAL ARPT MT 46.433 105.867 7 
24144 HELENA/ARPT MT 46.600 112.000 7 
24153 MISSOULA/JOHNSON-BELL FLD MT 46.917 114.083 7 
24036 LEWISTOWN/FAA ARPT MT 47.067 109.450 7 
24143 GREAT FALLS/INT'L ARPT MT 47.483 111.367 7 
94008 GLASGOW/INT'L ARPT MT 48.217 106.617 7 
24146 KALISPELL/GLACIER PK INT'L AP MT 48.300 114.267 7 

13748 WILMINGTON/NEW HANOVER COUNTY NC 34.267 77.900 5 
13881 CHARLOTTE/DOUGLAS INT'L ARPT NC 35.217 80.933 5 
93729 CAPE HATTERAS/WSO NC 35.267 75.550 5 
03812 ASHEVILLE/REGIONAL ARPT NC 35.433 82.550 5 
13722 RALEIGH/RALEIGH-DURHAM ARPT NC 35.867 78.783 5 
13723 GREENSBORO,HIGH POINT /WINSTO NC 36.083 79.950 5 

24011 BISMARCK/MUNICIPAL ARPT ND 46.767 100.750 6 
14914 FARGO/HECTOR FIELD ND 46.900 96.800 6 
94014 WILLISTON/SLOULIN INT'L ARPT ND 48.183 103.633 6 
24013 MINOT/FAA AIRPORT ND 48.267 101.283 6 

14939 LINCOLN/MUNICIPAL ARPT NE 40.850 96.750 6 
14935 GRAND ISLAND/ARPT NE 40.967 98.317 6 
24023 NORTH PLATTE/LEE BIRD FLD NE 41.133 100.683 6 
14942 OMAHA/EPPLEY AIRFIELD NE 41.300 95.900 6 
94918 NORTH OMAHA/NWSFO ARPT NE 41.367 96.017 6 
24028 SCOTTSBLUFF/COUNTY AIRPORT NE 41.867 103.600 7 
14941 NORFOLK/KARL STEFAN MEM ARPT NE 41.983 97.433 6 

14745 CONCORD/MUNICIPAL ARPT NH 43.200 71.500 5 
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93730 ATLANTIC CITY/AIRPORT NAFEC NJ 39.450 74.567 5 
14734 NEWARK/INT'L ARPT NJ 40.700 74.167 5 

23009 ROSWELL/INDUSTRIAL AIR PARK NM 33.300 104.533 7 
23050 ALBUQUERQUE/INT'L ARPT NM 35.050 106.617 7 
23081 GALLUP/FAA AIRPORT NM 35.517 108.783 7 

23169 LAS VEGAS/MCCARRAN INT'L ARPT NV 36.083 115.167 8 
03160 DESERT ROCK NV 36.617 116.017 8 
23154 ELY/YELLAND FIELD NV 39.283 114.850 8 
23185 RENO/CANNON INT'L ARPT NV 39.500 119.783 8 
24121 ELKO/MUNICIPAL ARPT NV 40.833 115.783 8 
24128 WINNEMUCCA/WSO AIRPORT NV 40.900 117.800 8 
24172 LOVELOCK/DERBY NV 40.066 118.550 8 
23153 TONOPAH NV 38.066 117.133 8 

94789 NEW YORK/J F KENNEDY INT'L AR NY 40.650 73.783 5 
14732 NEW YORK/LAGUARDIA ARPT NY 40.767 73.900 5 
04781 ISLIP NY 40.783 73.100 5 
04725 BINGHAMTON/EDWIN A LINK FIELD NY 42.217 75.983 5 
14735 ALBANY/COUNTY ARPT NY 42.750 73.800 5 
14733 BUFFALO/GREATER BUFFALO INT'L NY 42.933 78.733 5 
14771 SYRACUSE/HANCOCK INT'L ARPT NY 43.117 76.117 5 
14768 ROCHESTER/ROCHESTER-MONROE CO NY 43.117 77.667 5 
94725 MASSENA/FAA AIRPORT NY 44.933 74.850 5 

93815 DAYTON/INT'L ARPT OH 39.900 84.200 5 
14821 COLUMBUS/PORT COLUMBUS INT'L OH 40.000 82.883 5 
14895 AKRON/AKRON-CANTON REGIONAL OH 40.917 81.433 5 
14852 YOUNGSTOWN/MUNICIPAL ARPT OH 41.250 80.667 5 
14820 CLEVELAND/HOPKINS INT'L ARPT OH 41.417 81.867 5 
94830 TOLEDO/EXPRESS ARPT OH 41.600 83.800 5 

13967 OKLAHOMA CITY/WILL ROGERS WOR OK 35.400 97.600 6 
13968 TULSA/INT'L ARPT OK 36.200 95.900 6 

24225 MEDFORD/JACKSON COUNTY ARPT OR 42.383 122.883 8 
24284 NORTH BEND/FAA AIRPORT OR 43.417 124.250 8 
24221 EUGENE/MAHLON SWEET ARPT OR 44.117 123.217 8 
24230 REDMOND/FAA AIRPORT OR 44.267 121.150 8 
24232 SALEM/MCNARY FIELD OR 44.917 123.000 8 
24229 PORTLAND/INT'L ARPT OR 45.600 122.600 8 
24155 PENDLETON/MUNICIPAL ARPT OR 45.683 118.850 8 
94224 ASTORIA/CLATSOP COUNTY ARPT OR 46.150 123.883 8 

13739 PHILADELPHIA/INT'L ARPT PA 39.883 75.250 5 
14751 HARRISBURG/CAPITAL CITY ARPT PA 40.217 76.850 5 
94823 PITTSBURGH/WSCOM 2 AIRPORT PA 40.500 80.217 5 
14737 ALLENTOWN/BETLEHEM-EASTON ARP PA 40.650 75.433 5 
14778 WILLIAMSPORT-LYCOMING /COUNTY PA 41.250 76.917 5 
14777 WILKES-BARRE/WB-SCRANTON WSO PA 41.333 75.733 5 
04751 BRADFORD/FAA AIRPORT PA 41.800 78.633 5 
14860 ERIE/INT'L ARPT PA 42.083 80.183 5 
14711 MIDDLETOWN/OLMSTEAD ST PA 40.200 76.766 5 

11641 SAN JUAN/ISLA VERDE INT'L ARP PR 18.433 66.000 4 

14765 PROVIDENCE/T F GREEN STATE AR RI 41.733 71.433 5 

13880 CHARLESTON/INT'L ARPT SC 32.900 80.033 5 
13883 COLUMBIA/METRO ARPT SC 33.950 81.117 5 
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03870 GREER/GREENV'L-SPARTANBRG AP SC 34.900 82.217 5 

14944 SIOUX FALLS/FOSS FIELD SD 43.567 96.733 6 
24090 RAPID CITY/REGIONAL ARPT SD 44.050 103.067 7 
14936 HURON/REGIONAL ARPT SD 44.383 98.217 6 
24025 PIERRE/FAA AIRPORT SD 44.383 100.283 6 

13882 CHATTANOOGA/LOVELL FIELD TN 35.033 85.200 5 
13893 MEMPHIS/INT'L ARPT TN 35.050 90.000 6 
13891 KNOXVILLE/MC GHEE TYSON ARPT TN 35.800 84.000 5 
13897 NASHVILLE/METRO ARPT TN 36.117 86.683 6 
13877 BRISTOL/TRI CITY AIRPORT TN 36.483 82.400 5 

12919 BROWNSVILLE/INT'L ARPT TX 25.900 97.433 6 
12924 CORPUS CHRISTI/INT'L ARPT TX 27.767 97.500 6 
12912 VICTORIA/WSO AIRPORT TX 28.850 96.917 6 
12962 HONDO/WSMO AIRPORT TX 29.350 99.167 6 
12921 SAN ANTONIO/WSFO TX 29.533 98.467 6 
12917 PORT ARTHUR/JEFFERSON COUNTY TX 29.950 94.017 6 
12960 HOUSTON/INTERCONTINENTAL ARPT TX 29.967 95.350 6 
13958 AUSTIN/MUNICIPAL ARPT TX 30.283 97.700 6 
93987 LUFKIN/FAA AIRPORT TX 31.233 94.750 6 
23034 SAN ANGELO/WSO AIRPORT TX 31.367 100.500 6 
13959 WACO/MADISON-COOPER ARPT TX 31.617 97.217 6 
23044 EL PASO/INT'L ARPT TX 31.800 106.400 7 
23023 MIDLAND/REGIONAL AIR TERMINAL TX 31.950 102.183 6 
03969 STEPHENVILLE TX 32.217 98.183 6 
13962 ABILENE/MUNICIPAL ARPT TX 32.417 99.683 6 
03927 DALLAS/FORT WORTH/REGIONAL AR TX 32.900 97.033 6 
23042 LUBBOCK/REGIONAL ARPT TX 33.650 101.817 6 
13966 WICHITA FALLS/MUNICIPAL ARPT TX 33.967 98.483 6 
23047 AMARILLO/INT'L ARPT TX 35.233 101.700 6 

93129 CEDAR CITY/FAA AIRPORT UT 37.700 113.100 7 
24127 SALT LAKE CITY/INT'L ARPT UT 40.783 111.950 7 

13737 NORFOLK/INT'L ARPT VA 36.900 76.200 5 
13741 ROANOKE/WOODRUM ARPT VA 37.317 79.967 5 
13740 RICHMOND/R E BYRD INT'L ARPT VA 37.500 77.333 5 
13743 WASHINGTON DC/NATIONAL ARPT VA 38.850 77.033 5 
93738 WASHINGTON DC/DULLES INT'L AR VA 38.950 77.450 5 

14742 BURLINGTON/INT'L ARPT VT 44.467 73.150 5 

24243 YAKIMA/AIR TERMINAL WA 46.567 120.533 8 
24227 OLYMPIA/ARPT WA 46.967 122.900 8 
24233 SEATTLE/SEATTLE-TACOMA INT'L WA 47.450 122.300 8 
24157 SPOKANE/INT'L ARPT WA 47.633 117.533 8 
94240 QUILLAYUTE/WSO AIRPORT WA 47.950 124.550 8 

14839 MILWAUKEE/GENERAL MITCHELL FI WI 42.950 87.900 6 
14837 MADISON/DANE CO REGIONAL ARPT WI 43.133 89.333 6 
14920 LA CROSSE/MUNICIPAL ARPT WI 43.867 91.250 6 
14898 GREEN BAY/AUSTIN STRAUBEL FIE WI 44.483 88.133 6 
14991 EAU CLAIRE/FAA AIRPORT WI 44.867 91.483 6 

03872 BECKLEY/RALEIGH CO MEMORIAL A WV 37.783 81.117 5 
13866 CHARLESTON/KANAWHA ARPT WV 38.367 81.600 5 
03860 HUNTINGTON/TRI-STATE ARPT WV 38.367 82.550 5 

24018 CHEYENNE/MUNICIPAL ARPT WY 41.150 104.817 7 
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24027 ROCK SPRINGS/FAA AIRPORT WY 41.600 109.067 7 
24021 LANDER/HUNT FIELD WY 42.817 108.733 7 
24089 CASPER/NATRONA CO INT'L ARPT WY 42.917 106.467 7 
24029 SHERIDAN/COUNTY ARPT WY 44.767 106.967 7 
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Appendix E: Software Installation, Removal and Operating 
Instructions 

1 Initial Software Installation 

The CD delivered with the project contains three separate subdirectories with installation utilities that 
must be run in sequence to properly install the software. The OCD/5 installation routine has been 
established by other researchers and could not easily be modified for this project. This has resulted in 
the requirement for the multiple installation procedure. The installation procedure is as follows: 
1) Run the Setup.exe file in subdirectory 1OCD5setup. You may need to be logged on as an 

administrator for this step.
 
a) Follow the on-screen prompts for installation.
 
b) To simplify the setup procedure and final operation of all software components it is
 

recommended that the default drive and directory (C:\OCDMENU) be used in this 
installation. If a different drive must be used, the same drive must be used in the installations 
described in steps 2 and 3 below. Do not change the directory name. 

2)	 Run the WCDgas_2-0_Setup.exe file in the subdirectory 2WCDgasSetup. 
a)	 Be sure to change the installation location to C:\OCDMENU or to the drive and directory 

specified in step 1. This is accomplished by using the “Browse” button and selecting the new 
installation location from the directory tree. 

b) Once the proper installation location has been selected the default menu items can be used in 
the remainder of this installation. 

c) If you receive an error in registering OCX files, record the files names and use the regsvr32 
application to manually register the file: e.g. 

regsvr32 c:\windows\system32\mschrt20.ocx 
3) Run the installSLRaddIns.exe file in the subdirectory 3slrAddInstall. 

a) Again, be sure that the installation drive specified matches the one used in step 1 above. The 
directory name used in this portion of the install should be “OCDDATA”. 

b) Say yes to the “del Samples ?” prompt in the command window. 

note to the installer- all users must have full control over the C:\ocddata directory and it's contents. 

2 Software Removal 

The following steps can be taken to remove the software from the computer, should this be required. 
1) Run the “WCDgas_2-0_Setup.exe” file in the subdirectory 2WCDgasSetup and select the 

“remove software” option. 
2)	 Run the “uninstall.exe” program located in the C:\OCDMENU (or the drive and directory chosen 

for the software installation in step 1). At the end of this uninstall a window will appear indicating 
that a number of files were added after the install and were not be automatically deleted. These 
files can be deleted to completely clean the installed components from the system. 
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3 Example Use of Software Components 

The two programs WCDgas.exe and OCDMENU.exe are run individually from the default install 
directory (C:\OCDMENU or the menu specified in step 1 of the software installation). The programs 
can be run independently of each other. WCDgas is used to build the pipeline networks and model 
the behavior of the gas from sub sea leaks through the water column to the water surface. 
OCDMENU, the atmospheric dispersion model, uses the *.dat gas emissions file generated by 
WCDgas along with over-water and over-land meteorological data to predict the downwind 
concentrations of the gas being released at the surface. The following steps are provided as a guide to 
familiarize new users with the basic use of these two software programs using example data 
generated during the project. 

1)	 Run the WCDgas program by double clicking on the program icon present in the installation 
directory (C:\OCDMENU). 

2)	 Select the File->Open option and choose Pac36dpG.wcd from the OCDDATA directory. The 
*.wcd files contain the pipeline definitions generated for the project. Pac refers to Pacific Region 
(Gom – Gulf of Mexico), 36 refers to the pipeline diameter in inches, dp refers to a deep rupture 
location (sh – shallow) and G refers to a guillotine break (1 – 1 inch puncture). 

3)	 Initiate the Scenario->Calculate All option to calculate both the sub sea pipeline discharge and the 
bubble plume rise. 

4)	 Use the “Result-> Release or Nearfield Plot to review the gas behavior. 
5)	 Use Window-> New Summary Window to get a text summary of some of the inputs and outputs 

of the recent simulation. This window provides an average gas boil zone diameter which can be 
used in subsequent air dispersion modeling. 

6)	 The “Scenario->Calculate All” option also generates an output gas emissions summary file for 
use in OCD/5. For this scenario it is named Pac36dpG.dat. This is an ASCII text file that can be 
viewed in any text editor. 

7)	 OCDMENU is run after WCDgas has been used to generate the water surface gas emissions 
summary file. 

8) Run the OCD/5 program by double clicking on the OCDMENU.exe program icon present in the 
installation directory (C:\OCDMENU). 

9)	 Click on the initial screen that shows a graphic of a plume and the MMS logo to initiate the main 
menu view. 

10) Select the File-> Open option and select either Pacific.DAO or GOMEX.DAO. These files 
contain the study area definitions developed for the Pacific and Gulf of Mexico Regions, 
respectively. 

11) The remaining discussion assumes that the Pacific Region has been selected. 
12) Open the “Input-> Run Information dialog”. 
13) Note the year, Julian day and hour of the simulation setting. These can be changed to determine 

the effect of different meteorological conditions on the dispersion modeling outcome. For now 
leave them as they are set. 

14) Note the “Length of Run” and the “length of Averaging Period”. The length of Run must be no 
greater than the number of lines (or hours) of emissions data present in the emissions file 
generated by WCDgas in step 6. The Length of Averaging Period should always be set to 1 for 
this application. 

15) Open the “Input->Sources” option and select the “Define Sources” option. Only one source can 
be defined at a time or the software generates an error. Use the default source location for now. If 
a different spill location is desired in the future, edit the XY locations as described in the main 
body of the report to change the release point. Exit this menu option without making any changes. 
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16) The “Significant Sources” dialog appears to get corrupted occasionally when using OCDMENU. 
The problem is fixed by un-checking and re-checking the “Specify Significant Sources” box, then 
clicking on the source name (Pacific) to set the “Number of Significant Sources to zero and 
finally clicking on the Source name again to set the number to 1. These steps are described here 
because experience has shown this to be a recurring “bug” with the OCD/5 software. 

17) Open the “Run-Run OCD” option. 
18) Enter “b4602391.dat” in the ASCII Overwater Met Data File box, “Lmet91.dat” in the ASCII 

Over land Met Data File box, “Pac36dpg.dat” in the Hourly Emission File box, “Pac36dpg.out” 
in the Output Listing File Name, and “Pac36dpg.txt” in the Secondary Output Summary File 
Name box. 

19) “Run” the simulation using the button at the bottom of the dialog. 
20) If the simulation is successful a graph of the results will appear. “Right click and hold” on the 

graph and move the mouse to get different views of the plume concentration plot. Once the plot is 
closed it can be regained either by re-Running the simulation in OCDMENU or by using the 
“replot filename” option from a command window. The filename used is Pac36dpg.txt (or the 
secondary output file name specified in the Run OCD dialog). 

21) Once the data has been entered as described above a new simulation using Met data starting from 
a different hour or day of the year can be run by opening the “Input->Run Information” dialog 
and changing the starting Julian day or hour. Once the change has been made go back to the 
“Run-> Run OCD” option and re-run the simulation with the same Met input file names. Change 
the input files if Met data from a different year or location is of interest. The “number of 
significant sources” error often creeps into the picture after changing the starting day or hour of 
the simulation. Use the procedure described in step 16 to fix the problem if it is encountered. 
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